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Product notice

This guide describes features that are common
to most models. Some features may not be
available on your computer.

Not all features are available on all editions of
Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers, and/or software to take full
advantage of Windows 8 functionality. See
http://www.microsoft.com for details.

This computer may require upgraded and/ or
separately purchased hardware and/or a DVD
drive to install the Windows 7 software and
take full advantage of Windows 7 functionality.
See http://windows.microsoft.com/en-us/
windows7/get-know-windows-7 for details.



http://www.microsoft.com
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7

Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place the
device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do not
allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs or
clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as
pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-accessible
surface temperature limits defined by the International Standard for Safety of Information Technology
Equipment (IEC 60950).
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1 Product description

Intel HM76 Express Chipset models

Category Description Non-touch; Non-touch; Touch; Touch;
UMA discrete UMA discrete
Productname HP 15 Notebook PC v v v v
HP 15 TouchSmart Notebook PC v v v v
Compag 15 Notebook PC v v v v
Compag 15 TouchSmart Notebook PC v v v v
HP 250 G2 Notebook PC v v v v
Processors Intel i5-3230M processor (2.6-GHz, 3-MB cache, 35 W) v v v v
Intel i3-3110M processor (2.4-GHz, 3-MB cache, 35 W) v v v v
Intel Pentium 2020M processor (2.4-GHz, 2-MB cache, 35 W) v v v v
Intel Celeron 1000M processor (1.8-GHz, 2-MB cache, 35 W) v v v v
Chipset Intel HM76 Express v v v v
Graphics Switchable discrete graphics:
Nvidia 820M N15V-GM 1 GB VRAM (128Mx16 DDR3 1GHz x 4 v v
PCs)
GPU power management enabled at launch
Support DX11
Support dynamic switching
Support HD Decode and HDMI
UMA graphics:
Intel HD Graphics v v
Panel 39.6-cm (15.6-in), high-definition (HD), light-emitting diode v v v v
(LED), SVA BrightView (1366x768) display; typical brightness:
200 nits
Touchscreen, 39.6-cm (15.6-in), high-definition (HD), light- v v
emitting diode (LED), SVA AntiGlare (1366x768) display; typical
brightness: 200 nits
Supports 16:9 ultra wide aspect ratio
Supports LVDS v v v v
Memory 2 customer-accessible/upgradable memory module slots v v v v

Supports dual-channel memory

DDR3L-1600-MHz

Intel HM76 Express Chipset models
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2

Category Description Non-touch; Non-touch; Touch; Touch;
UMA discrete UMA discrete
Supports up to 16 GB of system RAM in the following v v v v
configurations:
° 16384-MB total system memory (8192x2; not supported
on a 32-bit operating system)
° 12288-MB total system memory (8192x1 + 4096 1; not
supported on a 32-bit operating system)
e  8192-MB total system memory (8192x1 or 4096x2)
e  6144-MB total system memory (4096x1 + 2048x1; not
supported on a 32-bit operating system)
° 4096-MB total system memory (4096x1 or 2048x2)
e  2048-MB total system memory (2048x1)
Hard drives Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and v v v v
7.0-mm (.28-in) thicknesses
Customer-accessible
Serial ATA
Supports the following hard drives: v v v v
° 1-TB, 5400-rpm, 9.5-mm
° 750-GB, 5400-rpm, 9.5-mm
° 500-GB, 5400-rpm, 9.5-mm or 7.0-mm
° 320-GB, 5400-rpm, 9.5-mm or 7.0-mm
Opticaldrive  Fixed v v v v
Serial ATA
9.5-mm tray load
DVD+/-RW Double-Layer SuperMulti v v v v
Supports zero power optical drive v v v v
Supports no optical drive option v v
Audio/video  Single digital microphone v v v v
HD audio v v v v
Dual speakers v v v v
HP TrueVision HD webcam (fixed, no tilt with activity LED, v v v v
1280x720 by 30 frames per second)
Ethernet Integrated 10/100 network interface card (NIC) v v v v
Integrated 10/100/1000 NIC (HP 250 models)
Wireless Integrated wireless local area network (WLAN) options by way v v v v
of wireless module
One or two WLAN antennas built into display assembly
Compatible with Miracast-certified devices (For Win8.1; except
Intel Pentium and Celeron)
Support for the following WLAN formats: v v v v

Chapter 1 Product description



Category Description Non-touch; Non-touch; Touch; Touch;
UMA discrete UMA discrete
° Realtek RTL8188EE 802.11bgn 1x1 Wi-Fi Adapter
e Qualcomm Atheros AR9485 802.11bgn 1x1 Wi-Fi Adapter
. Ralink RT3290LE 802.11bgn 1x1 Wi-Fi + BT 4.0 Combo
Adapter
° QCA 9565 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter
External HP Multi-Format Digital Media Reader v v v v
media card
Support SD/SDHC/SDXC
Push-Push Insertion/Removal
Ports AC Smart Pin adapter plug v v v v
Headphone/microphone in combo jack v v v v
HDMI version 1.4 supporting 1920 x1200 @ 60Hz v v v v
RJ-45 (Ethernet, includes link and activity lights) v v v v
USB 3.0 (1 port) v v v v
USB 2.0 (2 ports) v v v v
VGA (Dsub 15 pin) supporting 2048x1536 external resolution @ v v v v
75 Hz, hot plug and unplug and auto-detection for correct
output to wide-aspect vs. standard aspect video
Hot Plug/unplug and auto detect for correct output to wide-
aspect vs. standard aspect video
Keyboard/ Full-size "island style" keyboard with numeric keypad v v v v
pointing
devices
TouchPad with multi-touch gestures, 2-finger scrolling, and v v v v
pinch-zoom enabled
Taps enabled by default
Support Win8.1+D212 Modern Trackpad Gestures
Support PS/2, profile sensor(reserve for SMBus)
Power For computer systems with discrete graphics:
requirements
90-W Smart AC adapter; for use in all countries except China and v v
India)
90-W EM Smart AC adapter; for use in China and India only) v v
For computer systems with UMA graphics:
65-W Smart AC adapter; for use in all countries except China and v v
India)
65-W EM Smart AC adapter; for use in China and India only) v v
1 meter power cord v v v v
4-cell, 41-Whr Li-ion battery v v v v
3-cell, 31-Whr Li-ion battery v v v v

Intel HM76 Express Chipset models
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Category Description

Non-touch;

UMA

Non-touch;
discrete

Touch; Touch;
UMA discrete

Security Kensington Security Lock

Support Intel Anti-Theft

Support Intel IPT

OTP support

v

v

v v

Operating Preinstalled:

system
]

Windows 8.1

Windows 8.1 downgrade to Windows 7 Professional (HP
250 models)

Ubuntu

FreeD0S 2.0

Serviceability End-user replaceable parts:

AC adapter

Battery

Memory modules (2)
Optical drive

WLAN module

Intel Bay Trail chipset models

Category

Description

Non-touch; UMA

Touch; UMA

Product name

HP 15 Notebook PC

v

v

HP 15 TouchSmart Notebook PC

<

<

Compagqg 15 Notebook PC

Compagqg 15 TouchSmart Notebook PC

HP 250 G2 Notebook PC

Processors

Intel Pentium N3520 processor (2.4-GHz, 2-MB cache, 7.5 W)

Intel Pentium N3510 processor (2.0-GHz, 2-MB cache, 7.5 W)

Intel Celeron N2820 processor (2.13-GHz, 1-MB cache, 7.5 W)

Intel Celeron N2815 processor (2.13-GHz, 1-MB cache, 7.5 W)

Intel Celeron N2810 processor (2.0-GHz, 1-MB cache, 7.5 W)

Chipset

Bay Trail

L U U O O I

L U U O O I

Graphics

UMA graphics:

Intel HD graphics

<

<

Panel

39.6-cm (15.6-in), high-definition (HD), light-emitting diode (LED), SVA

BrightView (1366x768) display; typical brightness: 200 nits
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Category Description Non-touch; UMA Touch; UMA
Touchscreen, 39.6-cm (15.6-in), high-definition (HD), light-emitting v
diode (LED), SVA AntiGlare (1366x768) display; typical brightness: 200
nits
Supports 16:9 ultra wide aspect ratio
Supports LVDS v v
Memory 1 customer-accessible/upgradable memory module slots v v
Supports dual-channel memory
DDR3L-1600-MHz
Supports up to 8 GB of system RAM in the following configurations: v v
e  8192-MB total system memory (8192x1)
e  4096-MB total system memory (4096x1)
e  2048-MB total system memory (2048x1)
Hard drives Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and 7.0-mm (. v v
28-in) thicknesses
Customer-accessible
Serial ATA
Supports the following hard drives: v v
° 1-TB, 5400-rpm, 9.5-mm
° 750-GB, 5400-rpm, 9.5-mm
° 500-GB, 5400-rpm, 9.5-mm or 7.0-mm
° 320-GB, 5400-rpm, 9.5-mm or 7.0-mm
Optical drive Fixed v v
Serial ATA
9.5-mm tray load
DVD+/-RW Double-Layer SuperMulti v v
Supports zero power optical drive v v
Supports no optical drive option v
Audio/video Single digital microphone v v
HD audio v v
Dual speakers v v
HP TrueVision HD webcam (fixed, no tilt with activity LED, 1280x720 by v v
30 frames per second)
Ethernet Integrated 10/100 network interface card (NIC) v v
Wireless Integrated wireless local area network (WLAN) options by way of v v

wireless module
One or two WLAN antennas built into display assembly

Compatible with Miracast-certified devices (For Win8.1; except Intel
Pentium and Celeron)

Intel Bay Trail chipset models
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Category Description Non-touch; UMA Touch; UMA
Support for the following WLAN formats: v v
e  Realtek RTL8188EE 802.11bgn 1x1 Wi-Fi Adapter
° Qualcomm Atheros AR9485 802.11bgn 1x1 Wi-Fi Adapter
° Ralink RT3290LE 802.11bgn 1x1 Wi-Fi + BT 4.0 Combo Adapter
° QCA 9565 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter
External media HP Multi-Format Digital Media Reader v v
card Support SD/SDHC/SDXC
Push-Push Insertion/Removal
Ports AC Smart Pin adapter plug v v
Headphone/microphone in combo jack v v
HDMI version 1.4 supporting 1920 x1200 @ 60Hz v v
RJ-45 (Ethernet, includes link and activity lights) v v
USB 3.0 (1 port) v v
USB 2.0 (2 ports) v v
VGA (Dsub 15 pin) supporting 2560x1600 external resolution @ 60 Hz, v v
hot plug and unplug and auto-detection for correct output to wide-
aspect vs. standard aspect video
Hot Plug/unplug and auto detect for correct output to wide-aspect vs.
standard aspect video
Keyboard/ Full-size "island style" keyboard with numeric keypad v v
pointing devices
TouchPad with multi-touch gestures, 2-finger scrolling, and pinch- v v
zoom enabled
Taps enabled by default
Support Win8.1+D212 Modern Trackpad Gestures
Support PS/2, profile sensor(reserve for SMBus)
Power 45-W Smart AC adapter v v
requirements
1 meter power cord v v
4-cell, 41-Whr Li-ion battery v v
3-cell, 31-Whr Li-ion battery
Security Kensington Security Lock v v
Support Intel Anti-Theft
Support Intel IPT
OTP support
Operating Preinstalled: v v
system e  Windows 8.1
e  Ubuntu v
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Category

Description

Non-touch; UMA

Touch; UMA

° FreeD0OS

v

Serviceability

End-user replaceable parts:
° AC adapter

° Battery

e  Memory modules (2)

e  Optical drive

° WLAN module

v

AMD models

Category

Description

Non-touch;
UMA

Non-touch;
discrete

Touch; Touch;
UMA discrete

Product name

HP 15 Notebook PC

v

v

HP 15 TouchSmart Notebook PC

v

v

Compag 15 Notebook PC

<

Compagq 15 TouchSmart Notebook PC

HP 255 G2 Notebook PC

Processors

AMD A6-5200 (2.0 GHz, 2 MB cache, 25W

AMD A4-5000 (1.5 GHz, 2 MB cache, 15W)

AMD E2-3800 (1.3 GHz, 1 MB cache, 15W)

AMD E1-2100 (1.0 GHz, 1 MB cache, 9W)

HP Quad-Core, (1.55 GHz, 13W)

Intel Quad-Core, (1.55 GHz, 13W)

Intel Celeron HP Dual-Core, (1.05 GHz, 8W

L N O O . S S

< | 2 <<

L N U S N e S

< | X 2| <

Dual-Core, (1.05 GHz, 8W)

Chipset

Integrated SOC FCH

Graphics

Switchable discrete graphics:

AMD Sun LE (18W) Radeon™ HD 8570M with up to 1024 MB of
dedicated video memory (128Mx16 DDR3 1GHz x 4 PCs)

Support HD Decode, DX11, and HDMI
Support HD Decode, DX11.1, and HDMI
Support PX 7.0

UMA graphics:

AMD Radeon™ HD 8400 Graphics (A6-5200)

AMD Radeon HD 8330 Graphics (A4-5000)

AMD Radeon HD 8280 Graphics (E2-3800)

AMD models
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Category Description Non-touch; Non-touch; Touch; Touch;

UMA discrete UMA discrete
AMD Radeon HD 8210 Graphics (E1-2100) v v
Panel 39.6-cm (15.6-in), high-definition (HD), light-emitting diode v v v v
(LED), SVA BrightView (1366x768) display; typical brightness:
200 nits
Touchscreen, 39.6-cm (15.6-in), high-definition (HD), light- v v
emitting diode (LED), SVA AntiGlare (1366x768) display; typical
brightness: 200 nits
Supports 16:9 ultra wide aspect ratio
Supports LVDS v v v v
Memory 1 customer-accessible/upgradable memory module slots v v v v
Supports dual-channel memory
DDR3L-1600-MHz
Supports up to 8 GB of system RAM in the following v v v v
configurations:
e  8192-MB total system memory (8192)
e  4096-MB total system memory (4096x1)
e  2048-MB total system memory (2048x1)
Hard drives Supports 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and v v v v
7.0-mm (.28-in) thicknesses
Customer-accessible
Serial ATA
Supports the following hard drives: v v v v
° 1-TB, 5400-rpm, 9.5-mm
° 750-GB, 5400-rpm, 9.5-mm
° 500-GB, 5400-rpm, 9.5-mm or 7.0-mm
° 320-GB, 5400-rpm, 9.5-mm or 7.0-mm
Opticaldrive  Fixed v v v v
Serial ATA
9.5-mm tray load
DVD+/-RW Double-Layer SuperMulti v v v v
Supports zero power optical drive v v v v
Supports no optical drive option v v
Audio/video Single digital microphone v v v v
HD audio v v v v
Dual speakers v v v v
HP TrueVision HD webcam (fixed, no tilt with activity LED, v v v v
1280x720 by 30 frames per second)
Ethernet Integrated 10/100 network interface card (NIC) v v v v
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Category

Description

Non-touch;
UMA

Non-touch;
discrete

Touch; Touch;
UMA discrete

Integrated 10/100/1000 NIC (HP 255 models)

Wireless

Integrated wireless local area network (WLAN) options by way of
wireless module

One or two WLAN antennas built into display assembly

Compatible with Miracast-certified devices (For Win8.1; except
Intel Pentium and Celeron)

Support for the following WLAN formats:
° Realtek RTL8188EE 802.11bgn 1x1 Wi-Fi Adapter
e  Qualcomm Atheros AR9485 802.11bgn 1x1 Wi-Fi Adapter

e  Ralink RT3290LE 802.11bgn 1x1 Wi-Fi + BT 4.0 Combo
Adapter

° QCA 9565 802.11bgn 1x1 Wi-Fi + BT4.0 Combo Adapter

External
media card

HP Multi-Format Digital Media Reader
Support SD/SDHC/SDXC

Push-Push Insertion/Removal

Ports

AC Smart Pin adapter plug

Headphone/microphone in combo jack

HDMI version 1.4 supporting 1920 x1200 @ 60Hz

RJ-45 (Ethernet, includes link and activity lights)

USB 3.0 (1 port)

USB 2.0 (2 ports)

VGA (Dsub 15 pin) supporting 2048x1536 external resolution @
75 Hz, hot plug and unplug and auto-detection for correct output
to wide-aspect vs. standard aspect video

Hot Plug/unplug and auto detect for correct output to wide-
aspect vs. standard aspect video

L Y U O

L - S I I

L - S I I
L S U

Keyboard/
pointing
devices

Full-size "island style" keyboard with numeric keypad

TouchPad with multi-touch gestures, 2-finger scrolling, and
pinch-zoom enabled

Taps enabled by default
Support Win8.1+D212 Modern Trackpad Gestures

Support PS/2, profile sensor(reserve for SMBus)

Power
requirements

65-W Smart AC adapter; for use in all countries except China and
India)

65-W EM Smart AC adapter; for use in China and India only)

45-W Smart AC adapter; for use in all countries except China and
India)

1 meter power cord

AMD models
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Category Description Non-touch; Non-touch; Touch; Touch;
UMA discrete UMA discrete
4-cell, 41-Whr Li-ion battery v v v v
3-cell, 31-Whr Li-ion battery
Security Kensington Security Lock v v v v
Support Intel Anti-Theft
Support Intel IPT
OTP support
Operating Preinstalled: v v v v
system e  Windows 8.1
e  Ubuntu v v
e  FreeD0S 2.0 v v
Serviceability End-user replaceable parts: v v v v

° AC adapter

° Battery

e Memory modules (2)
° Optical drive

e  WLAN module
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2 External component identification

Right side

0ee

Component

Description

(1

C

Power light

° On: The computer is on.

e  Blinking: The computer is in the Sleep state, a
power-saving state. The computer shuts off power
to the display and other unneeded components.

e Off: The computer is off or in Hibernation.
Hibernation is a power-saving state that uses the
least amount of power.

NOTE: For select models, the Intel® Rapid Start
Technology feature is enabled at the factory.
Rapid Start Technology allows your computer to
resume quickly from inactivity.

(2)

Hard drive light

Blinking white: The hard drive is being accessed.

(3)

USB 2.0 ports (2)

Connect an optional USB device, such as a keyboard,
mouse, external drive, printer, scanner or USB hub.

(4)

€ & (0

Optical drive (select models only)

Depending on your computer model, reads an optical
disc or reads and writes to an optical disc.

NOTE: For disc compatibility information, go to the
Help and Support web page. Follow the web page
instructions to select your computer model. Select
Support & Drivers, and then select Product
Information.

(5)

Optical drive eject button (select models
only)

Releases the disc tray.

Right side

11



Left side

Component

Description

(1)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or
stolen.

(2)

Power connector

Connects an AC adapter.

(3)

“w 4 P

AC adapter light

e  On:The AC adapter is connected and the battery is
charged.

° Amber: The AC adapter is connected and the battery is
charging.

e  Off: The computer is using battery power.

(4)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(5)

1031

External monitor port

Connects an external VGA monitor or projector.

(6)

RJ-45 (network) jack/status lights

Connects a network cable.
e  White: The network is connected.

e  Amber: Activity is occurring on the network.

(7)

HDMI port

Connects an optional video or audio device, such as a high-
definition television, any compatible digital or audio
component, or a high-speed HDMI device.

(8)

USB 3.0 port

Connects an optional USB device, such as a keyboard, mouse,
external drive, printer, scanner or USB hub.

9)

Audio-out (headphone)/Audio-in (microphone)
jack

12 Chapter 2 External component identification

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or a television audio cable. Also connects an
optional headset microphone. This jack does not support
optional microphone-only devices.

WARNING! Toreduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset.
For additional safety information, refer to the Regulatory,
Safety, and Environmental Notices. To access this guide in
Windows 8, from the Start screen, type support, and then
select the HP Support Assistant app.



Component

Description

NOTE: When a device is connected to the jack, the computer
speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and audio-
in (microphone).

Front

Component

Description

n Memory card reader

Reads optional memory cards that store, manage,
share, or access information.

Toinsert a card:

Hold the card label-side up, with connectors facing the
slot, insert the card into the slot, and then push in on the
card until it is firmly seated.

Toremove a card:

Press in on the card it until it pops out.

Front
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Display

= NOTE:

Refer to the image that most closely matches your computer.

Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless local
area networks (WLANs)

(2) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless wide
area networks (WWAN).

3) Webcam light On: The webcam is in use.

(a) Webcam Records video and captures photographs. Some models allow you to
video conference and chat online using streaming video.
To use the webcam in Windows 8, from the Start screen, type
camera, and then select Camera from the list of applications.
To use the webcam in Windows 7, select Start > All Programs >
Communication and Chat > CyberLink YouCam.

(5) Internal microphone Records sound.

(6) Internal display switch Turns off the display and initiates Sleep if the display is closed while

the power is on.

NOTE: The internal display switch is not visible from the outside of
the computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the
antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices
that applies to your country or region. To access this guide in Windows 8, from the Start screen, type support, and then select the
HP Support Assistant app.

Chapter 2 External component identification



Top
TouchPad

o | e

Component Description
(1) TouchPad zone Moves the on-screen pointer and selects or activates items on
the screen.
NOTE: The TouchPad also supports edge-swipe gestures.
() Left TouchPad button Functions like the left button on an external mouse.
3) Right TouchPad button

Functions like the right button on an external mouse.

Top
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Lights

Y

Component

Description

1 Caps lock light

On: Caps lock is on, which switches the keys to all capital letters.

(2 ‘ ® Mute light

e  Amber: Computer sound is off.

e  Off: Computer sound is on.

(3) {: I :} Wireless light

On: An integrated wireless device, such as a wireless local area
network (WLAN) device and/or a Bluetooth® device, is on.

NOTE: Onsome models, the wireless light is amber when all
wireless devices are off.

Chapter 2 External component identification



Button

Component

Description

LI) Power button

e  When the computer is off, press the button to turn on the
computer.

e  When the computer is on, press the button briefly to
initiate Sleep.

° When the computer is in the Sleep state, press the button
briefly to exit Sleep.

e  When the computer is in Hibernation, press the button
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button will
result in the loss of unsaved information.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button
down for at least 5 seconds to turn off the computer.

NOTE: For select models, the Intel® Rapid Start Technology
feature is enabled at the factory. Rapid Start Technology allows
your computer to resume quickly from inactivity.

To learn more about your power settings, see your power
options. In Windows 8, from the Start screen, type power,
select Power and sleep settings, and then select Power and
sleep from the list of applications.

In Windows 7, select Start > Control Panel > System and
Security > Power Options.

Top
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Keys

L]

&)

Component Description

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with the spacebaror the esc key.

3) an Windows key Returns you to the Start screen from an open app or the

L1 | Windows desktop.

NOTE: Pressing the Windows key again will return you to the
previous screen.

(a) Action keys Execute frequently used system functions.

(5) num lk key Alternates between the navigational and numeric functions on
the integrated numeric keypad.
NOTE: The keypad function that is active when the computer
is turned off is reinstated when the computer is turned back on.

(6) Integrated numeric keypad When num Lk has been enabled, it can be used like an external

numeric keypad. To alternate between this numeric function
and the navigational function (indicated by the directional
arrows on the keys), press the num |k key.

Chapter 2 External component identification



Bottom

Component

Description

(1

o
&

Battery lock and unlock latch

Locks and unlocks the battery in the battery bay.

(2) Battery bay Holds the battery.

3) Vents (5) Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) i Battery release latch Releases the battery.

(5) Speaker openings (2) Produce sound.

(6) Service door Provides access to the wireless LAN (WLAN) module slot,

e

the memory module slots, and the optical drive bay (select
models only).

Bottom
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Component Description

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support through
Help and Support. In Windows 78, from the Start screen,
type help, and then select Help and Support.

Labels

The labels affixed to the computer provide information you may need when you troubleshoot system
problems or travel in the Netherlands with the computer.

@IMPORTANT: All labels described in this section will be located in one of 3 places depending on your
computer model: Affixed to the bottom of the computer, located in the battery bay, or under the service
door.

e  Service label—Provides important information to identify your computer. When contacting support,
you will probably be asked for the serial number, and possibly for the product number or the model
number. Locate these numbers before you contact support.

E”%NOTE: Your service labels will resemble one of the examples shown below. Refer to the illustration
that most closely matches the service label on your computer.
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L Model: J0000CK

Component

(1) Product name

(2) Serial number

3) Product number

(4)  Warranty period

(5)  Model number (select models only)

gimﬁﬁrm L

l 000K
(4 mmmpc

10 B 000000 0D DOOO 00000
NN e e

Component

(1) Serial number

(2) Product number

(3)  Warranty period

Labels 21



Component

(@)  Model number (select models only)

(5) Revision number

e  Regulatory label(s)—Provide(s) regulatory information about the computer.

e  Wireless certification label(s)—Provide(s) information about optional wireless devices and the approval
markings for the countries or regions in which the devices have been approved for use.
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3 Ilustrated parts catalog

Computer major components
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Item Component Spare part number

(1 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen)

NOTE: For display assembly spare part information, see Display assembly subcomponents on page 31.

For use in HP 15 models:

e  Black 747121-001
e  White 747122-001
e Red 747123-001
e  Blue 750199-001
° Purple 750200-001

For use in Compag 15 models:

. Gray 747124-001

. Blue 750201-001

° Purple 750202-001
(2) Top cover (includes keyboard):

For use in black HP 15 and Compag 15 models:

e  Foruseinthe United States 747140-001
e  ForuseinFrance 747140-051
e  Foruseinltaly 747140-061
e  ForuseinSpain 747140-071
° For use in Portugal 747140-131
e  Forusein Turkey 747140-141
e  Forusein Greece 747140-151
e  Forusein Latin America 747140-161
e  Forusein SaudiArabia 747140-171
e  ForuseinHungary 747140-211
e  ForuseinRussia 747140-251
° For use in Bulgaria 747140-261
° For use in Romania 747140-271
e  Forusein Thailand 747140-281
° For use in Japan 747140-291
° For use in Taiwan 747140-AB1
e  Forusein South Korea 747140-AD1
e  Forusein the Netherlands 747140-B31
e  ForuseinSlovenia 747140-BA1
e  Foruseinlsrael 747140-BB1
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Item Component Spare part number
e  ForuseinFrench Canada 747140-DB1
. For use in Denmark, Finland, and Norway 747140-DH1
e  Foruseinthe Czech Republic and Slovakia 747140-FL1
For use in white HP 15 and Compaq 15 models:

e  Forusein the United States 747141-001
e  ForuseinFrance 747141-051
e  Foruseinltaly 747141-061
° For use in Spain 747141-071
° For use in Portugal 747141-131
° For use in Turkey 747141-141
e  ForuseinGreece 747141-151
e  ForuseinLatin America 747141-161
e  Forusein SaudiArabia 747141171
° For use in Hungary 747141-211
e  ForuseinRussia 747141-251
° For use in Bulgaria 747141-261
e  ForuseinRomania 747141-271
e  Forusein Thailand 747141-281
° For use in Japan 747141-291
e  ForuseinTaiwan 747141-AB1
e  ForuseinSouth Korea 747141-AD1
e  Foruseinthe Netherlands 747141-B31
e  ForuseinSlovenia 747141-BA1
e  Foruseinlsrael 747141-BB1
e  ForuseinFrench Canada 747141-DB1
. For use in Denmark, Finland, and Norway 747141-DH1
e  Foruseinthe Czech Republic and Slovakia 747141-FL1
For use in red HP 15 and Compaq 15 models:

e  Forusein the United States 747142-001
e  ForuseinFrance 747142-051
e  Foruseinltaly 747142-061
° For use in Spain 747142-071
e  ForuseinPortugal 747142-131
e  Forusein Turkey 747142-141

Computer major components
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Item Component Spare part number
e  ForuseinGreece 747142-151
e  ForuseinLatin America 747142-161
e  Forusein SaudiArabia 747142-171
° For use in Hungary 747142-211
e  ForuseinRussia 747142-251
° For use in Bulgaria 747142-261
e  Forusein Romania 747142-271
e  Forusein Thailand 747142-281
° For use in Japan 747142-291
e  ForuseinTaiwan 747142-AB1
e  ForuseinSouthKorea 747142-AD1
e  Foruseinthe Netherlands 747142-B31
e  ForuseinSlovenia 747142-BA1
e  Foruseinlsrael 747142-BB1
e  ForuseinFrench Canada 747142-DB1
. For use in Denmark, Finland, and Norway 747142-DH1
e  Foruseinthe Czech Republic and Slovakia 747142-FL1
For use in blue HP 15 and Compaq 15 models:

e  Forusein the United States 750195-001
e  Forusein Greece 750195-151
e  Forusein Saudi Arabia 750195-171
e  ForuseinRussia 750195-251
e  Forusein Thailand 750195-281
e  ForuseinTaiwan 750195-AB1
e  ForuseinSouthKorea 750195-AD1
e  Foruseinthe Netherlands 750195-B31
e  ForuseinFrench Canada 750195-DB1
For use in purple HP 15 and Compag 15 models:

e Forusein the United States 750196-001
e  Forusein Greece 750196-151
e  Forusein Saudi Arabia 750196-171
e  ForuseinRussia 750196-251
e  Forusein Thailand 750196-281
e  ForuseinTaiwan 750196-AB1
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Item Component Spare part number
e  ForuseinSouth Korea 750196-AD1
e  Foruseinthe Netherlands 750196-B31
e  ForuseinFrench Canada 750196-DB1
For use in gray HP 15 and Compaq 15 models:

e  Forusein the United States 747143-001
e  Foruseinthe United Kingdom 747143-031
e  Forusein Germany 747143-041
e  ForuseinFrance 747143-051
° For use in Spain 747143-071
° For use in Portugal 747143-131
e  Forusein Turkey 747143-141
e  ForuseinGreece 747143-151
e  ForuseinLatin America 747143-161
e  ForuseinSaudiArabia 747143-171
e  ForuseinRussia 747143-251
° For use in Belgium 747143-A41
e  Foruseinthe Netherlands 747143-B31
e  ForuseinSwitzerland 747143-BG1
e  ForuseinFrench Canada 747143-DB1
e  Forusein Denmark, Finland, and Norway 747143-DH1
For use in black HP 250 and HP 255 models:

e  Forusein the United States 749022-001
e  Foruseinthe United Kingdom 749022-031
e  Forusein Germany 749022-041
e  ForuseinFrance 749022-051
e  Foruseinltaly 749022-061
e  ForuseinSpain 749022-071
e  ForuseinPortugal 749022-131
e  Forusein Turkey 749022-141
e  ForuseinGreece 749022-151
e  ForuseinLatin America 749022-161
e  Forusein SaudiArabia 749022-171
° For use in Hungary 749022-211
e  ForuseinRussia 749022-251

Computer major components
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Item Component Spare part number
e  ForuseinBulgaria 749022-261
e  Forusein Thailand 749022-281
° For use in Japan 749022-291
° For use in Europe 749022-A41
e  ForuseinTaiwan 749022-AB1
e  ForuseinSouth Korea 749022-AD1
e  Foruseinthe Netherlands 749022-B31
e  ForuseinSlovenia 749022-BA1
e  Foruseinlsrael 749022-BB1
e  ForuseinSwitzerland 749022-BG1
e  ForuseinFrench Canada 749022-DB1
e  Forusein Denmark, Finland, and Norway 749022-DH1
° For use in the Czech Republic and Slovakia 749022-FL1
3) Touchpad button board (includes cable) 747127-001
(4) Power button board (includes cable) 747128-001
(5) Fan/heat sink assembly (includes replacement thermal materials):
NOTE: Bay Trail models support only a heat sink. Bay Trail models do not support a fan.
For use in models with Intel processors:
° UMA graphics and HM76 chipset 747241-001
e  UMA graphics and HM86 chipset 747384-001
° UMA graphics and Bay Trail chipset 747243-001
e  Discrete graphics and HM76 chipset 747242-001
For use in models with AMD processors:
° UMA graphics 747266-001
° Discrete graphics 747267-001
(6) Power connector cable 747116-001
(1)} USB board (includes cable) 747126-001
(8) Card reader board (includes cable) 747129-001
(9) System board (includes replacement thermal materials):
For use only in models with Intel processors:
° UMA graphics, Intel HM86 chipset, without Windows 8 747136-001
e  UMA graphics, Intel HM86 chipset, Windows 8 Standard 747136-501
° UMA graphics, Intel HM86 chipset, Windows 8 Professional 747136-601
° UMA graphics, Intel HM76 chipset, without Windows 8 747137-001
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Item Component Spare part number
° UMA graphics, Intel HM76 chipset, Windows 8 Standard 747137-501
e  UMA graphics, Intel HM76 chipset, Windows 8 Professional 747137-601
e  Discrete graphics, Intel HM76 chipset, without Windows 8 748839-001
e  Discrete graphics, Intel HM76 chipset, Windows 8 Standard 748839-501
e  Discrete graphics, Intel HM76 chipset, Windows 8 Professional 748839-601
e  UMA graphics, Pentium N3520 processor, without Windows 8 753099-001
e  UMA graphics, Pentium N3520 processor, Windows 8 Standard 753099-501
° UMA graphics, Pentium N3520 processor, Windows 8 Professional 753099-601
° UMA graphics, Pentium N3510 processor, without Windows 8 747138-001
° UMA graphics, Pentium N3510 processor, Windows 8 Standard 747138-501
° UMA graphics, Pentium N3510 processor, Windows 8 Professional 747138-601
° UMA graphics, Celeron N2820 processor, without Windows 8 753100-001
° UMA graphics, Celeron N2820 processor, Windows 8 Standard 753100-501
e  UMA graphics, Celeron N2820 processor, Windows 8 Professional 753100-601
e  UMA graphics, Celeron N2810 processor, without Windows 8 747139-001
e  UMA graphics, Celeron N2810 processor, Windows 8 Standard 747139-501
e UMA graphics, Celeron N2810 processor, Windows 8 Professional 747139-601
For use in models with an AMD A6-5200 processor and UMA graphics:

e  Without Windows 8 747150-001
e  Windows 8 Standard 747150-501
For use in models with AMD A4-5000 processors and UMA graphics:

e  Without Windows 8 747148-001
e  Windows 8 Standard 747148-501
For use in models with AMD E1-2100 processors and UMA graphics:

e  Without Windows 8 747149-001
e  Windows 8 Standard 747149-501
For use in models with an AMD A4-5000 processor and discrete graphics:

e  Without Windows 8 747151-001
e  Windows 8 Standard 747151-501
For use in models with an AMD E2-3800 processor and discrete graphics:

e  Without Windows 8 748452-001
e  Windows 8 Standard 748452-501
For use only in models with an AMD E1-2100 processor and discrete graphics:

e  Without Windows 8 747152-001

Computer major components
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e  Windows 8 Standard 747152-501
(10) Optical drive connector 747119-001
11 RTC battery 747132-001
(12) Memory module (PC3L, 12800, 1600-MHz):

NOTE: Bay Trail models support only one memory module.

8-GB 693374-001

4GB 691740-001

2GB 691739-001
(13) Processor (includes replacement thermal materials):

Separate processors only available for models with Intel processors.

Intel Core i5 3230M processor (2.60-GHz, 3.0-MB L3 cache, dual core, 35 W) 711903-002

Intel Core i3 4000M processor (2.40-GHz processor, 3.0-MB L3 cache, dual core, 37 W) 737327-001

Intel Core i3 3110M processor (2.40-GHz, 3.0-MB L3 cache, dual core, 35 W) 682417-001

Intel Pentium 2020M processor (2.40-GHz, 2.0-MB L3 cache) 700628-001

Intel Celeron 1000M processor (1.8-GHz processor, 2.0-MB L3 cache, dual core, 35 W) 713162-001
(14) Hard drive connector 747118-001
(15) Hard drive (SATA; does not include bracket):

NOTE: The hard drive bracket is available using spare part number 747117-001.

1-GB, 5400-rpm, 2.5-in 676521-005

750-GB, 5400-rpm, 2.5-in 634250-005

500-GB, 5400-rpm 669299-005

320-GB, 5400-rpm, 2.5-in (for use only in HP 250 models) 622643-005
(16) Speakers (includes left and right speakers and cable) 747135-001
a7 Battery:

4-cell, 41-Whr, 2.8-Ah Li-ion battery 740715-001

3-cell, 31-Whr, 2.8-Ah Li-ion battery 746641-001
(18) Base enclosure 747112-001
(19) Optical drive (DVD+/-RW Double-Layer SuperMulti) 747125-001
(20) WLAN module:

Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001

Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo Adapter 690020-001

Atheros AR9565 802.11bgn 1x1 WiFi + BT4.0 combo Adapter 733476-001

Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-001
(21) Service door 747130-001
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NOTE: Included in the Plastics Kit.

Display assembly subcomponents
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Item Component Spare part number
(1) Display bezel (includes Mylar screw covers):
For use with HP 15 models 747113-001
For use with Compag 15 models 747114-001
For use with HP 250 and HP 255 models 749553-001
(2) Webcam/microphone module 747144-001
3) Raw display panel (39.6-cm [15.6-in], HD, WLED, BrightView)
For use in HP 15 and Compaq 15 models 747131-001
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Item Component Spare part number
For use in HP 250 and HP 255 models 749020-001
(@) Hinges (left and right) 747120-001
(5) Display cable (includes display panel cable and webcam/microphone cable) 747115-001
(6) Antennas (includes wireless antenna cables and transceivers) 747107-001
(v)) Display enclosure:
For use in HP 15 and Compaq 15 models:
e  Black 747108-001
e  White 747109-001
e Red 747110-001
e  Blue 750197-001
e  Gray 747111-001
° Purple 750198-001
For use in HP 250 and HP 255 models
° Black 749015-001
Mass storage devices
Component Spare part number
Hard drive, SATA; does not include bracket):
1-GB, 5400-rpm, 2.5-in 676521-005
750-GB, 5400-rpm, 2.5-in 634250-005
500-GB, 5400-rpm 669299-005
320-GB, 5400-rpm, 2.5-in (for use only in HP 250 models) 622643-005
Hard drive bracket 747117-001
Optical drive (DVD+/-RW Double-Layer SuperMulti) 747125-001
Optical drive connector 747119-001
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Plastics Kit
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Item Component Spare part number
Plastics Kit, includes: 747130-001

(1) Service door

(2) Optical drive cover (for use in models without an optical drive)

Rubber Kit

Component Spare part number
Rubber Kit for use in HP 15 and Compaq 15 models 747133-001
Rubber Kit for use in HP 250 models 756215-001
Rubber Kit for use in HP 255 models 751418-001

Display rubber pieces for back, front, and side

Mylar display screw covers

Rubber feet

Keyboard aluminum foil pieces (4)

Tape, control board
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Miscellaneous parts

Component Spare part number

HP Smart AC adapter:

For use with computer models equipped with discrete graphics:

e  90-W PFC HP Smart AC adapter (for use in all countries except China and India) 710413-001

e  90-W PFC EM HP Smart AC adapter (for use in China and India only) 710414-001

For use with computer models equipped with UMA graphics:

e  65-W non-PFC HP Smart AC adapter (for use in all countries except China and India) 710412-001
e  65-W non-PFC EM HP Smart AC adapter (for use in China and India only) 714657-001
] 45-W non-PFC, non-slim HP Smart AC adapter 741427-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01
For use in Australia 490371-011
For use in Denmark 490371-081
For use in Europe, the Middle East, and Africa 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Italy 490371-061
For use in Japan 490371-291
For use in North America 490371-001
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in Thailand 490371-201
For use in the United Kingdom and Singapore 490371-031
Rubber Kit

For use in HP 15 and Compaq 15 models 747133-001
For use in HP 250 models 756215-001
For use in HP 255 models 751418-001
Screw Kit 747134-001
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Spare part Description

number

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe, the Middle East, and Africa (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-081 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-111 Power cord for use in Italy (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

622643-005 320-GB, 5400-rpm, 2.5-in SATA hard drive for use only in HP 250 models (does not include cable or bracket)

634250-005 750-GB, 5400-rpm, 2.5-in SATA hard drive (does not include cable or bracket)

669299-005 500-GB, 5400-rpm, 2.5-in SATA hard drive (does not include cable or bracket)

675794-001 Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter

682417-001 Intel Core i3-3110M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes replacement
thermal materials)

690020-001 Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo Adapter

691739-001 2-GB memory module (PC3L, 12800, 1600-MHz)

691740-001 4-GB memory module (PC3L, 12800, 1600-MHz)

693374-001 8-GB memory module (PC3L, 12800, 1600-MHz)

700628-001 Intel Pentium 2020M, 2.40-GHz processor (2.0-MB L3 cache, dual core, 35 W)

709848-001 Realtek RTL8188EE 802.11bgn Wi-Fi Adapter

710412-001 65-W non-PFC HP Smart AC adapter for use with computer models equipped with UMA graphics (for use in all
countries except China and India)

710413-001 90-W PFC HP Smart AC adapter for use with computer models equipped with discrete graphics (for use in all
countries except China and India)

710414-001 90-W PFC EM HP Smart AC adapter for use with computer models equipped with discrete graphics (for use in China

and India only)
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number

711903-002 Intel Core i5, 3230M 2.60-GHz processor (3.0-MB L3 cache, dual core, 35 W)

713162-001 Intel Celeron 1000M, 1.8-GHz processor (2.0-MB L3 cache, dual core, 35 W)

714657-001 65-W non-PFC EM HP Smart AC adapter (for use in China and India only)

733476-001 Atheros AR9565 802.11bgn 1x1 WiFi + BT4.0 combo Adapter

737327-001 Intel Core i3 4000M, 2.40-GHz processor (3.0-MB L3 cache, dual core, 37 W)

740715-001 4-cell, 41-Whr, 2.8-Ah Li-ion battery

741427-001 45-W non-PFC, non-slim HP Smart AC adapter

746641-001 3-cell, 31-Whr, 2.8-Ah Li-ion battery

747107-001 Antennas (includes wireless antenna cables and transceivers)

747108-001 Display enclosure for use on black HP 15 and Compaq 15 models

747109-001 Display enclosure for use on white HP 15 and Compaq 15 models

747110-001 Display enclosure for use on red HP 15 and and Compagqg 15 models 15 models

747111-001 Display enclosure for use on gray HP 15 and Compag 15 models

747112-001 Base enclosure

747113-001 Display bezel for use with HP 15 models

747114-001 Display bezel for use with Compaq 15 models

747115-001 Display cable (includes display panel cable and webcam/microphone cable)

747116-001 Power connector cable

747117-001 Hard drive bracket

747118-001 Hard drive cable

747119-001 Optical drive connector

747120-001 Hinges (left and right)

747121-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in for use in HP 15 black modelsBlack
747122-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in HP 15 white models
747123-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in HP branded red models
747124-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in Compagq 15 gray models
747125-001 DVD+/-RW Double-Layer SuperMulti Drive

747126-001 USB board (includes cable)

747127-001 TouchPad button board (includes cable)

747128-001 Power button board (includes cable)

747129-001 Card reader board (includes cable)

747130-001 Plastics Kit (includes service door and optical drive cover (for use in models without an optical drive)
747131-001 Raw display panel for use in HP 15 and Compag 15 models

747132-001 RTC battery
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number

747133-001 Rubber Kit for use in HP 15 and Compaq 15 models

747134-001 Screw Kit

747135-001 Speakers (includes left and right speakers and cable)

747136-001 System board for use only in models with UMA graphics, Intel HM86 chipset, and without Windows 8 (includes
replacement thermal materials)

747136-501 System board for use only in models with UMA graphics, Intel HM86 chipset, and Windows 8 Standard (includes
replacement thermal materials)

747136-601 System board for use only in models with UMA graphics, Intel HM86 chipset, and Windows 8 Professional (includes
replacement thermal materials)

747137-001 System board for use only in models with UMA graphics, Intel HM76 chipset, and without Windows 8 (includes
replacement thermal materials)

747137-501 System board for use only in models with UMA graphics, Intel HM76 chipset, and Windows 8 Standard (includes
replacement thermal materials)

747137-601 System board for use only in models with UMA graphics, Intel HM76 chipset, and Windows 8 Professional (includes
replacement thermal materials)

747138-001 System board for use only in models with UMA graphics, Pentium N3510 processor, without Windows 8 (includes
replacement thermal materials)

747138-501 System board for use only in models with UMA graphics, Pentium N3510 processor, and Windows 8 Standard
(includes replacement thermal materials)

747138-601 System board for use only in models with UMA graphics, Pentium N3510 processor, and Windows 8 Professional
(includes replacement thermal materials)

747139-001 System board for use only in models with UMA graphics, Celeron N2810 processor, without Windows 8 (includes
replacement thermal materials)

747139-501 System board for use only in models with UMA graphics, Celeron N2810 processor, and Windows 8 Standard
(includes replacement thermal materials)

747139-601 System board for use only in models with UMA graphics, Celeron N2810 processor, and Windows 8 Professional
(includes replacement thermal materials)

747140-001 Top cover with keyboard for use in black HP 15 and Compaq 15 models in the United States

747140-051 Top cover with keyboard for use in black HP 15 and Compag 15 models in France

747140-061 Top cover with keyboard for use in black HP 15 and Compaq 15 models in Italy

747140-071 Top cover with keyboard for use in black HP 15 and Compag 15 models in Spain

747140-131 Top cover with keyboard for use in black HP 15 and Compaq 15 models in Portugal

747140-141 Top cover with keyboard for use in black HP 15 and Compag 15 models in Turkey

747140-151 Top cover with keyboard for use in black HP 15 and Compagq 15 models in Greece

747140-161 Top cover with keyboard for use in black HP 15 and Compaq 15 models in Latin America

747140-171 Top cover with keyboard for use in black HP 15 and Compagq 15 models in Saudi Arabia

747140-211 Top cover with keyboard for use in black HP 15 and Compagq 15 models in Hungary

747140-251 Top cover with keyboard for use in black HP 15 and Compaq 15 models in Russia

747140-261 Top cover with keyboard for use in black HP 15 and Compaq 15 models in Bulgaria

Sequential part number listing
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747140-271 Top cover with keyboard for use in black HP 15 and Compag 15 models in Romania

747140-281 Top cover with keyboard for use in black HP 15 and Compag 15 models in Thailand

747140-291 Top cover with keyboard for use in black HP 15 and Compaq 15 models in Japan

747140-AB1 Top cover with keyboard for use in black HP 15 and Compaq 15 models in Taiwan

747140-AD1 Top cover with keyboard for use in black HP 15 and Compaq 15 models in South Korea

747140-B31 Top cover with keyboard for use in black HP 15 and Compag 15 models in the Netherlands

747140-BA1 Top cover with keyboard for use in black HP 15 and Compag 15 models in Slovenia

747140-BB1 Top cover with keyboard for use in black HP 15 and Compag 15 models in Israel

747140-DB1 Top cover with keyboard for use in black HP 15 and Compagq 15 in French Canada

747140-DH1 Top cover with keyboard for use in black HP 15 and Compag 15 models in Denmark, Finland, and Norway
747140-FL1 Top cover with keyboard for use in black HP 15 and Compagq 15 models in the Czech Republic and Slovakia
747141-001 Top cover with keyboard for use in white HP 15 and Compag 15 models in the United States

747141-051 Top cover with keyboard for use in white HP 15 and Compagq 15 models in France

747141-061 Top cover with keyboard for use in white HP 15 and Compag 15 models in Italy

747141-071 Top cover with keyboard for use in white HP 15 and Compaq 15 models in Spain

747141-131 Top cover with keyboard for use in white HP 15 and Compaq 15 models in Portugal

747141-141 Top cover with keyboard for use in white HP 15 and Compaq 15 models in Turkey

747141-151 Top cover with keyboard for use in white HP 15 and Compagqg 15 models in Greece

747141-161 Top cover with keyboard for use in white HP 15 and Compagq 15 models in Latin America

747141-171 Top cover with keyboard for use in white HP 15 and Compag 15 models in Saudi Arabia

747141-211 Top cover with keyboard for use in white HP 15 and Compag 15 models in Hungary

747141-251 Top cover with keyboard for use in white HP 15 and Compagq 15 models in Russia

747141-261 Top cover with keyboard for use in white HP 15 and Compagqg 15 models in Bulgaria

747141-271 Top cover with keyboard for use in white HP 15 and Compagq 15 models in Romania

747141-281 Top cover with keyboard for use in white HP 15 and Compag 15 models in Thailand

747141-291 Top cover with keyboard for use in white HP 15 and Compag 15 models in Japan

747141-AB1 Top cover with keyboard for use in white HP 15 and Compaq 15 models in Taiwan

747141-AD1 Top cover with keyboard for use in white HP 15 and Compaq 15 models in South Korea

747141-B31 Top cover with keyboard for use in white HP 15 and Compaq 15 models in the Netherlands

747141-BA1 Top cover with keyboard for use in white HP 15 and Compag 15 models in Slovenia

747141-BB1 Top cover with keyboard for use in white HP 15 and Compag 15 models in Israel

747141-DB1 Top cover with keyboard for use in white HP 15 and Compagq 15 in French Canada

747141-DH1 Top cover with keyboard for use in white HP 15 and Compag 15 models in Denmark, Finland, and Norway
747141-FL1 Top cover with keyboard for use in white HP 15 and Compag 15 models in the Czech Republic and Slovakia
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747142-001 Top cover with keyboard for use in red HP 15 and Compagqg 15 models in the United States
747142-051 Top cover with keyboard for use in red HP 15 and Compag 15 models in France
747142-061 Top cover with keyboard for use in red HP 15 and Compaq 15 models in Italy

747142-071 Top cover with keyboard for use in red HP 15 and Compagq 15 models in Spain

747142-131 Top cover with keyboard for use in red HP 15 and Compag 15 models in Portugal
747142-141 Top cover with keyboard for use in red HP 15 and Compag 15 models in Turkey
747142-151 Top cover with keyboard for use in red HP 15 and Compag 15 models in Greece
747142-161 Top cover with keyboard for use in red HP 15 and Compag 15 models in Latin America
747142-171 Top cover with keyboard for use in red HP 15 and Compag 15 models in Saudi Arabia
747142-211 Top cover with keyboard for use in red HP 15 and Compag 15 models in Hungary
747142-251 Top cover with keyboard for use in red HP 15 and Compag 15 models in Russia
747142-261 Top cover with keyboard for use in red HP 15 and Compag 15 models in Bulgaria
747142-271 Top cover with keyboard for use in red HP 15 and Compag 15 models in Romania
747142-281 Top cover with keyboard for use in red HP 15 and Compag 15 models in Thailand
747142-291 Top cover with keyboard for use in red HP 15 and Compag 15 models in Japan
747142-AB1 Top cover with keyboard for use in red HP 15 and Compag 15 models in Taiwan
747142-AD1 Top cover with keyboard for use in red HP 15 and Compaq 15 models in South Korea
747142-B31 Top cover with keyboard for use in red HP 15 models in the Netherlands

747142-BA1 Top cover with keyboard for use in red HP 15 and Compag 15 models in Slovenia
747142-BB1 Top cover with keyboard for use in red HP 15 and Compag 15 models in Israel
747142-DB1 Top cover with keyboard for use in red HP 15 and Compagq 15 in French Canada
747142-DH1 Top cover with keyboard for use in red HP 15 and Compag 15 models in Denmark, Finland, and Norway
747142-FL1 Top cover with keyboard for use in red HP 15 and Compag 15 models in the Czech Republic and Slovakia
747143-001 Top cover with keyboard for use in gray HP 15 and Compag 15 models in the United States
747143-031 Top cover with keyboard for use in gray HP 15 and Compag 15 models in the United Kingdom
747143-041 Top cover with keyboard for use in gray HP 15 and Compagq 15 models in Germany
747143-051 Top cover with keyboard for use in gray HP 15 and Compagq 15 models in France
747143-071 Top cover with keyboard for use in gray HP 15 and Compagq 15 models in Spain
747143-131 Top cover with keyboard for use in gray HP 15 and Compag 15 models in Portugal
747143-141 Top cover with keyboard for use in gray HP 15 and Compag 15 models in Turkey
747143-151 Top cover with keyboard for use in gray HP 15 and Compag 15 models in Greece
747143-161 Top cover with keyboard for use in gray HP 15 and Compag 15 models in Latin America
747143-171 Top cover with keyboard for use in gray HP 15 and Compag 15 models in Saudi Arabia
747143-251 Top cover with keyboard for use in gray HP 15 and Compaq 15 models in Russia

Sequential part number listing
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747143-A41 Top cover with keyboard for use in gray HP 15 and Compag 15 models in Belgium

747143-B31 Top cover with keyboard for use in gray HP 15 and Compaq 15 models in the Netherlands

747143-BG1 Top cover with keyboard for use in gray HP 15 and Compaq 15 models in Switzerland

747143-DB1 Top cover with keyboard for use in gray HP 15 and Compag 15 in French Canada

747143-DH1 Top cover with keyboard for use in gray HP 15 and Compag 15 models in Denmark, Finland, and Norway

747144-001 Webcam/microphone module

747148-001 System board for use only with computer models without Windows 8 and equipped with an AMD A4-5000
processor and UMA graphics (includes replacement thermal materials)

747148-501 System board for use only with computer models with Windows 8 Standard and equipped with an AMD A4-5000
processor and UMA graphics (includes replacement thermal materials)

747149-001 System board for use only with computer models without Windows 8 and equipped with an AMD E1-2100
processor and UMA graphics (includes replacement thermal materials)

747149-501 System board for use only with computer models with Windows 8 Standard and equipped with an AMD E1-2100
processor and UMA graphics (includes replacement thermal materials)

747150-001 System board for use only with computer models without Windows 8 and equipped with an AMD A6-5200
processor and UMA graphics (includes replacement thermal materials)

747150-501 System board for use only with computer models with Windows 8 Standard and equipped with an AMD A6-5200
processor and UMA graphics (includes replacement thermal materials)

747151-001 System board for use only with computer models without Windows 8 and equipped with an AMD A4-5000
processor and discrete graphics (includes replacement thermal materials)

747151-501 System board for use only with computer models with Windows 8 Standard and equipped with an AMD A4-5000
processor and discrete graphics (includes replacement thermal materials)

747152-001 System board for use only with computer models without Windows 8 and equipped with an AMD E1-2100
processor and discrete graphics (includes replacement thermal materials)

747152-501 System board for use only with computer models with Windows 8 Standard and equipped with an AMD E1-2100
processor and discrete graphics (includes replacement thermal materials)

747241-001 Fan/heat sink assembly for use in models with Intel processors, UMA graphics, and Intel HM76 chipset
(includes replacement thermal materials)

747242-001 Fan/heat sink assembly for use in models with Intel processors, discrete graphics, and Intel HM76 chipset
(includes replacement thermal materials)

747243-001 Fan/heat sink assembly for use in models with Intel processors, UMA graphics, and Intel Bay Trail chipset
(includes replacement thermal materials)

747266-001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and UMA graphics
(includes replacement thermal materials)

747267-001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and discrete graphics
(includes replacement thermal materials)

747384-001 Fan/heat sink assembly for use in models with Intel processors, UMA graphics, and Intel HM86 chipset
(includes replacement thermal materials)

748452-001 System board for use only with computer models without Windows 8 and equipped with an AMD E2-3800
processor and discrete graphics (includes replacement thermal materials)

748452-501 System board for use only with computer models with Windows 8 Standard and equipped with an AMD E2-3800

processor and discrete graphics (includes replacement thermal materials)
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748839-001 System board for use only in models with discrete graphics, Intel HM76 chipset, and without Windows 8 (includes
replacement thermal materials)

748839-501 System board for use only in models with discrete graphics, Intel HM76 chipset, and Windows 8 Standard (includes
replacement thermal materials)

748839-601 System board for use only in models with discrete graphics, Intel HM76 chipset, and Windows 8 Professional
(includes replacement thermal materials)

749015-001 Display enclosure for use on black HP 250 and HP 255 models

749020-001 Raw display panel for use in HP 250 and HP 255 models

749022-001 Top cover with keyboard for use in black HP 250 and HP 255 models in the United States

749022-031 Top cover with keyboard for use in black HP 250 and HP 255 models in the United Kingdom

749022-041 Top cover with keyboard for use in black HP 250 and HP 255 models in Germany

749022-051 Top cover with keyboard for use in black HP 250 and HP 255 models in France

749022-061 Top cover with keyboard for use in black HP 250 and HP 255 models in Italy

749022-071 Top cover with keyboard for use in black HP 250 and HP 255 models in Spain

749022-131 Top cover with keyboard for use in black HP 250 and HP 255 models in Portugal

749022-141 Top cover with keyboard for use in black HP 250 and HP 255 models in Turkey

749022-151 Top cover with keyboard for use in black HP 250 and HP 255 models in Greece

749022-171 Top cover with keyboard for use in black HP 250 and HP 255 models in Saudi Arabia

749022-211 Top cover with keyboard for use in black HP 250 and HP 255 models in Hungary

749022-251 Top cover with keyboard for use in black HP 250 and HP 255 models in Russia

749022-261 Top cover with keyboard for use in black HP 250 and HP 255 models in Bulgaria

749022-281 Top cover with keyboard for use in black HP 250 and HP 255 models in Thailand

749022-291 Top cover with keyboard for use in black HP 250 and HP 255 models in Japan

749022-A41 Top cover with keyboard for use in black HP 250 and HP 255 models in Europe

749022-AB1 Top cover with keyboard for use in black HP 250 and HP 255 models in Taiwan

749022-AD1 Top cover with keyboard for use in black HP 250 and HP 255 models in South Korea

749022-B31 Top cover with keyboard for use in black HP 250 and HP 255 models in the Netherlands

749022-BA1 Top cover with keyboard for use in black HP 250 and HP 255 models in Slovenia

749022-BB1 Top cover with keyboard for use in black HP 250 and HP 255 models in Israel

749022-BG1 Top cover with keyboard for use in black HP 250 and HP 255 models in Switzerland

749022-DB1 Top cover with keyboard for use in black HP 250 and HP 255 models in French Canada

749022-DH1 Top cover with keyboard for use in black HP 250 and HP 255 models in Denmark, Finland, and Norway

749022-FL1 Top cover with keyboard for use in black HP 250 and HP 255 models in the Czech Republic and Slovakia

749553-001 Display bezel for use with HP 250 and HP 255 models

750195-001 Top cover with keyboard for use in blue HP 15 and Compaq 15 models in the United States
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Spare part Description

number

750195-151 Top cover with keyboard for use in blue HP 15 and Compaq 15 models in Greece

750195-171 Top cover with keyboard for use in blue HP 15 and Compaq 15 models in Saudi Arabia

750195-251 Top cover with keyboard for use in blue HP 15 and Compaq 15 models in Russia

750195-281 Top cover with keyboard for use in blue HP 15 and Compaq 15 models in Thailand

750195-AB1 Top cover with keyboard for use in blue models in Taiwan

750195-AD1 Top cover with keyboard for use in blue HP 15 and Compagq 15 models in South Korea

750195-B31 Top cover with keyboard for use in blue HP 15 and Compag 15 models in international models

750195-DB1 Top cover with keyboard for use in blue HP 15 and Compagq 15 models in French Canada

750196-001 Top cover with keyboard for use in purple HP 15 and Compagq 15 models in the United States

750196-151 Top cover with keyboard for use in purple HP 15 and Compag 15 models in Greece

750196-171 Top cover with keyboard for use in purple HP 15 and Compag 15 models in Saudi Arabia

750196-251 Top cover with keyboard for use in purple HP 15 and Compagq 15 models in Russia

750196-281 Top cover with keyboard for use in purple HP 15 and Compag 15 models in Thailand

750196-AB1 Top cover with keyboard for use in purple HP 15 and Compagqg 15 models in Taiwan

750196-AD1 Top cover with keyboard for use in purple HP 15 and Compaq 15 models in South Korea

750196-B31 Top cover with keyboard for use in purple HP 15 and Compaq 15 models in international models

750196-DB1 Top cover with keyboard for use in purple HP 15 and Compag 15 models in French Canada

750197-001 Display enclosure for use on blue HP 15 and Compaq 15 models

750198-001 Display enclosure for use on purple HP 15 and Compaq 15 models

750199-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in blue HP 15 models

750200-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in purple HP 15 models

750201-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in blue Compag 15 models

750202-001 Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in purple Compaq 15 models

751418-001 Rubber Kit for use in HP 255 models

753099-001 System board for use only in models with UMA graphics, Pentium N3510 processor, without Windows 8 (includes
replacement thermal materials)

753099-501 System board for use only in models with UMA graphics, Pentium N3510 processor, and Windows 8 Standard
(includes replacement thermal materials)

753099-601 System board for use only in models with UMA graphics, Pentium N3510 processor, and Windows 8 Professional
(includes replacement thermal materials)

753100-001 System board for use only in models with UMA graphics, Celeron N2820 processor, without Windows 8 (includes
replacement thermal materials)

753100-501 System board for use only in models with UMA graphics, Celeron N2820 processor, and Windows 8 Standard

(includes replacement thermal materials)
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Spare part Description

number

753100-601 System board for use only in models with UMA graphics, Celeron N2820 processor, and Windows 8 Professional
(includes replacement thermal materials)

756215-001 Rubber Kit for use in HP 250 models
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Magnetic screwdriver

e  Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.

=2’ NOTE:  As you remove each subassembly from the computer, place the subassembly (and all accompanying
screws) away from the work area to prevent damage.

Plastic parts

A CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care
when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the
reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or
seat the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases,
avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables
tear easily.

Preliminary replacement requirements
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Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the

computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure
that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

46

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal
cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its life
expectancy.

A CAUTION: To prevent damage to the computer when you are removing or installing internal components,

observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described in this
section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

A CAUTION: A product can be degraded by as little as 700 V.
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Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000V 15,000V 7,500V
Walking across vinyl floor 12,000V 5,000V 3,000V
Motions of bench worker 6,000V 800V 400V
Removing DIPS from plastic tube 2,000V 700V 400V
Removing DIPS from vinyl tray 11,500V 4,000V 2,000V
Removing DIPS from Styrofoam 14,500V 5,000V 3,500V
Removing bubble pack from PCB 26,500V 20,000V 7,000V
Packing PCBs in foam-lined box 21,000V 11,000V 5,000V

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or non-conductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to avoid
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and
equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

Preliminary replacement requirements
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Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a
minimum of one megohm +10% resistance in the ground cords. To provide proper ground, wear a strap

snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips

to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be
used at standing workstations and are compatible with most types of shoes or boots. On conductive
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance
between the operator and ground. To be effective, the conductive must be worn in contact with the
skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastics Bags 1,500V
Carbon-loaded plastic Floor mats 7,500V
Metallized laminate Floor mats 5,000V
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Component replacement procedures

This chapter provides removal and replacement procedures.

Make special note of each screw's size and location during removal and replacement.

Battery
Description Spare part number
4-cell, 41-Whr, 2.8-Ah Li-ion battery 740715-001
3-cell, 31-Whr, 2.8-Ah Li-ion battery 746641-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

To remove the battery:
1.  Turnthe computer upside down on a flat surface.
2. Slide the battery lock latch (1), and then slide the battery release latch (2) to release the battery.

3. Remove the battery from the computer (3).

Component replacement procedures
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Display subcomponents (bezel, webcam, panel)

This section describes removing display subcomponents that do not require that you remove the entire
display assembly from the computer. You can remove the display bezel, webcam/microphone module, and
display panel while the display assembly is still attached to the computer.

To remove the remaining display subcomponents, you must remove the entire display assembly from the
computer. See Display assembly on page 71 for more information about removing the display assembly in

its entirety.
Description Spare part number
Raw display panel for use in HP 15 and Compaq 15 models 747131-001
Raw display panel for use in HP 250 models and HP 255 models 749020-001
Display bezel for use with HP 15 models 747113-001
Display bezel for use with Compag 15 models 747114-001
Display bezel for use with HP 250 and HP 255 models 749553-001
Webcam/microphone module 747144-001

Before removing display subcomponents while the display assembly is still attached to the computer, follow
these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

To remove the display bezel, webcam/microphone module, and raw display panel:

1.  Position the computer upright with the front toward you, and then open it.
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2. Remove the two Mylar screw covers (1) and the two Phillips PM2.5x4.5 screws (2) that secure the
display bezel to the display assembly.

3. Flex theinside of the top edge (1), the left and right sides (2), and the bottom edge (3) of the display
bezel until the bezel disengages from the display enclosure.

4. Remove the display bezel (4).

5. Toremove the webcam/microphone module:
a. Position the display assembly with the top edge toward you.

b. Disconnect the cable (1) from the module.
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¢.  Lift to disengage the adhesive that secures the webcam/microphone module to the display, and
then remove the module (2).
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6. Toremove the display panel:

a. Remove the six Phillips PM2.5x4.0 screws (1) that secure the display panel to the enclosure, and
then rotate the display panel and hinges forward to gain access to the hinge screws (2).
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b. Remove the six Phillips PM2.0x3.0 screws (1) that secure the display panel to the hinges, and then
rotate the display panel onto the keyboard (2).
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¢.  Ontheback of the display panel, release the adhesive strip (1) that secures the display panel cable
to the display panel, and then disconnect (2) and remove (3) the cable.

Reverse this procedure to reassemble and install the display bezel, webcam/microphone module, and display
panel.
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Service door

@NOTE: The service door is available in the Plastics Kit.

Description Spare part number

Plastics Kit 747130-001

Before removing the service door, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

To remove the service door:
1.  Remove the service door screw (1).

2. Slide the service door toward the front of the computer (2), and then lift up and remove the service door

(3).

Reverse this procedure to install the service door.
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Optical drive

Description Spare part number

DVD+/-RW Double-Layer SuperMulti Drive 747125-001

Before removing the optical drive, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the service door (see Service door on page 56).

To remove the optical drive:
1. Remove the Phillips PM2.5x6.5 screw (1) that secures the optical drive to the computer.

2. Insert a screwdriver or similar small tool into the hole at the rear of the optical drive bay, and then push
the optical drive (2) to release it from the bay.

3. Remove the optical drive (3) by sliding it out of the optical drive bay.

4. Ifitis necessary to replace the optical drive bracket on the rear of the optical drive, position the optical
drive with the rear panel toward you.

5. Remove the two Phillips PM2.0x%3.0 screws (1) that secure the bracket to the optical drive.
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6. Remove the optical drive bracket (2).

oo &

Reverse this procedure to reassemble and install the optical drive.

Chapter 4 Removal and replacement procedures

\0



WLAN module

Description Spare part number
Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001
Ralink RT3290LE 802.11bgn 1x1 Wi-Fi and Bluetooth 4.0 Combo Adapter 690020-001
Atheros AR9565 802.11bgn 1x1 WiFi + BT4.0 combo Adapter 733476-001
Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-001

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in your
country or region. If you replace the module and then receive a warning message, remove the module to
restore device functionality, and then contact support.

Before removing the WLAN module, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Remove the service door (see Service door on page 56).

To remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

=2 NOTE: The #1 WLAN antenna cable is connected to the WLAN module Main terminal. The #2 WLAN
antenna cable is connected to the WLAN module Aux terminal.

2. Remove the Phillips PM2.0x%3.0 screw (2) that secures the WLAN module to the system board. (The
WLAN module tilts up.)
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3. Remove the WLAN module by pulling the module away from the slot at an angle (3).

= NOTE:  If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Memory module

E%?NOTE: Bay Trail models support only one memory module.

Description Spare part number
8-GB (PC3L, 12800, 1600-MHz) 693374-001
4-GB (PC3L, 12800, 1600-MHz) 691740-001
2-GB (PC3L, 12800, 1600-MHz) 691739-001

Before removing a memory module, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the service door (see Service door on page 56).

To remove a memory module:

1.

2.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.

(The memory module tilts up.)

Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.
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Top cover/keyboard

@NOTE: The top cover spare part kit includes the TouchPad.

Description Spare part number
Top cover with keyboard for use in black HP 15 and Compaq 15 models:

e  Foruseinthe United States 747140-001
e  ForuseinFrance 747140-051
e  Foruseinltaly 747140-061
° For use in Spain 747140-071
e  ForuseinPortugal 747140-131
e  Forusein Turkey 747140-141
e  ForuseinGreece 747140-151
° For use in Latin America 747140-161
e  Forusein SaudiArabia 747140-171
° For use in Hungary 747140-211
e  ForuseinRussia 747140-251
e  ForuseinBulgaria 747140-261
e  ForuseinRomania 747140-271
e  Forusein Thailand 747140-281
° For use in Japan 747140-291
° For use in Taiwan 747140-AB1
e  ForuseinSouth Korea 747140-AD1
e  Foruseinthe Netherlands 747140-B31
e  ForuseinSlovenia 747140-BA1
e  Foruseinlsrael 747140-BB1
e  ForuseinFrench Canada 747140-DB1
e  Forusein Denmark, Finland, and Norway 747140-DH1
e  Foruseinthe Czech Republic and Slovakia 747140-FL1
Top cover with keyboard for use in white HP 15 and Compagq 15 models:

e  Foruseinthe United States 747141-001
e  ForuseinFrance 747141-051
e  Forusein ltaly 747141-061
e  ForuseinSpain 747141-071
e  ForuseinPortugal 747141-131
e  Forusein Turkey 747141-141
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Description Spare part number
e  Forusein Greece 747141-151
e  Forusein Latin America 747141-161
e  Forusein Saudi Arabia 747141-171
° For use in Hungary 747141-211
e  ForuseinRussia 747141-251
e  ForuseinBulgaria 747141-261
e  Forusein Romania 747141-271
e  Forusein Thailand 747141-281
° For use in Japan 747141-291
e  Forusein Taiwan 747141-AB1
e  Forusein SouthKorea 747141-AD1
e  Foruseinthe Netherlands 747141-B31
e  ForuseinSlovenia 747141-BA1
e  Foruseinlsrael 747141-BB1
e  ForuseinFrench Canada 747141-DB1
. For use in Denmark, Finland, and Norway 747141-DH1
e  Foruseinthe Czech Republic and Slovakia 747141-FL1
Top cover with keyboard for use in red HP 15 and Compaq 15 models:

e  Foruseinthe United States 747142-001
e  ForuseinFrance 747142-051
e  Foruseinltaly 747142-061
° For use in Spain 747142-071
e  ForuseinPortugal 747142-131
e  Forusein Turkey 747142-141
e  Forusein Greece 747142-151
e  Forusein Latin America 747142-161
e  Forusein Saudi Arabia 747142-171
° For use in Hungary 747142-211
e  ForuseinRussia 747142-251
e  ForuseinBulgaria 747142-261
e  Forusein Romania 747142-271
e  Forusein Thailand 747142-281
° For use in Japan 747142-291
e  Forusein Taiwan 747142-AB1
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Description Spare part number
e  Forusein South Korea 747142-AD1
e  Foruseinthe Netherlands 747142-B31
° For use in Slovenia 747142-BA1
e  Foruseinlsrael 747142-BB1
e  ForuseinFrench Canada 747142-DB1
° For use in Denmark, Finland, and Norway 747142-DH1
e  Forusein the Czech Republic and Slovakia 747142-FL1
Top cover with keyboard for use in blue HP 15 and Compaq 15 models:

e  Foruseinthe United States 750195-001
e  ForuseinGreece 750195-151
e  Forusein SaudiArabia 750195-171
e  ForuseinRussia 750195-251
e  Forusein Thailand 750195-281
° For use in Taiwan 750195-AB1
° For use in South Korea 750195-AD1
e  Foruseinthe Netherlands 750195-B31
e  ForuseinFrench Canada 750195-DB1
Top cover with keyboard for use in purple HP 15 and Compaq 15 models:

e  Forusein the United States 750196-001
e  ForuseinGreece 750196-151
e  Forusein SaudiArabia 750196-171
e  ForuseinRussia 750196-251
e  Forusein Thailand 750196-281
e  ForuseinTaiwan 750196-AB1
e  Forusein South Korea 750196-AD1
e  Foruseinthe Netherlands 750196-B31
e  ForuseinFrench Canada 750196-DB1
Top cover with keyboard for use in gray HP 15 and Compaq 15 models:

e  Forusein the United States 747143-001
e  Forusein the United Kingdom 747143-031
e  Forusein Germany 747143-041
e  ForuseinFrance 747143-051
° For use in Spain 747143-071
e  ForuseinPortugal 747143-131
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Description Spare part number
e  Forusein Turkey 747143-141
° For use in Greece 747143-151
° For use in Latin America 747143-161
e  Forusein SaudiArabia 747143-171
e  ForuseinRussia 747143-251
e  Forusein Belgium 747143-A41
e  Foruseinthe Netherlands 747143-B31
e  Forusein Switzerland 747143-BG1
e  ForuseinFrench Canada 747143-DB1
° For use in Denmark, Finland, and Norway 747143-DH1
Top cover with keyboard for use in black HP 250 and HP 255 models:

e  Foruseinthe United States 749022-001
e  Foruseinthe United Kingdom 749022-031
° For use in Germany 749022-041
° For use in France 749022-051
e  Foruseinltaly 749022-061
° For use in Spain 749022-071
e  ForuseinPortugal 749022-131
° For use in Turkey 749022-141
e  Forusein Greece 749022-151
e  ForuseinLatin America 749022-161
e  Forusein Saudi Arabia 749022-171
e  ForuseinHungary 749022-211
e  ForuseinRussia 749022-251
e  ForuseinBulgaria 749022-261
e  Forusein Thailand 749022-281
° For use in Japan 749022-291
° For use in Europe 749022-A41
o For use in Taiwan 749022-AB1
e  Forusein South Korea 749022-AD1
e  Foruseinthe Netherlands 749022-B31
e  ForuseinSlovenia 749022-BA1
e  Foruseinlsrael 749022-BB1
e  Forusein Switzerland 749022-BG1
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Description Spare part number

° For use in French Canada 749022-DB1
. For use in Denmark, Finland, and Norway 749022-DH1
e  Forusein the Czech Republic and Slovakia 749022-FL1

Before removing the top cover/keyboard, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

5. Remove the service door (see Service door on page 56).

=7 NOTE: When replacing the top cover, be sure that the power button board and cable (see Power button
board on page 69) is removed from the defective top cover and installed on the replacement top cover:

To remove the top cover/keyboard:

1. Close the computer, and then position the computer upside down with the front toward you.
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2. Disconnect the following cables:
(1): Power button board cable
(2): Keyboard cable
(3): Touchpad cable

3.

4. Position the computer upright with the front toward you, and then open the computer.

5. Lift the rear edge of the top cover (1) until the left and right sides disengage from the base enclosure.
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6. Remove the top cover (2).

Reverse this procedure to install the top cover/keyboard.

Note the antenna routing path on the bottom of the computer when reassembling the computer.
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Power button board

Description Spare part number

Power button board (includes cable) 747128-001

Before removing the power button board, follow these steps:

1.

5.
6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49), and then remove the following components:

Remove the service door (see Service door on page 56).

Remove the top cover (see Top cover/keyboard on page 62).

To remove the power button board:

1.

2
3.
4

Position the top cover upside down with the front toward you.
Lift the cable to disengage it from the top cover (1).
Remove the two Phillips PM2.0x3.0 screws (2) that secure the power button board to the top cover.

Remove the power button board and cable (3).

Reverse this procedure to install the power button board and cable.

Component replacement procedures

69



TouchPad button board

Description Spare part number

TouchPad button board (includes cable) 747127-001

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

5. Remove the service door (see Service door on page 56).

6. Remove the top cover (see Top cover/keyboard on page 62).

To remove the TouchPad button board:

1. Position the top cover upside down with the front toward you.

2. Remove the two Phillips PM2.0x3.0 screws (1) that secure the TouchPad button board to the top cover.
3. Rotate the board upward (2).

4. Remove the TouchPad button board and cable (3).

Reverse this procedure to install the power button board and cable.
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Display assembly

This section describes removing the display assembly in its entirety and disassembling all the display
subcomponents.

If you only need to remove the display bezel, webcam/microphone module, or display panel, you do not need
to remove the entire display assembly from the computer. See Display subcomponents (bezel, webcam,
panel) on page 50 for more information about removing the display subcomponents that do not require that
you remove the entire display assembly from the computer.

Description Spare part number
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in black HP 15 models 747121-001
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in white HP 15 models 747122-001
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in red HP models 747123-001
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in gray Compaq 15 models 747124-001
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in blue HP 15 models 750199-001
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in purple HP 15 models 750200-001
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in blue Compagq 15 models 750201-001
Display assembly (39.6-cm [15.6-in] HD, anti-glare, touchscreen, for use in purple Compagq 15 models 750202-001
Raw display panel for use in HP 15 and Compaq 15 models 747131-001
Raw display panel for use in HP 250 models and HP 255 models 749020-001
Antennas (includes wireless antenna cables and transceivers) 747107-001
Display bezel for use in HP 15 models 747113-001
Display bezel for use in Compaq 15 models 747114-001
Display cable (includes display panel cable and webcam/microphone cable) 747115-001
Display enclosure for use in black HP 15 and Compag 15 models 747108-001
Display enclosure for use in white HP 15 and Compaq 15 models 747109-001
Display enclosure for use in red HP 15 and Compag 15 models 747110-001
Display enclosure for use in gray HP 15 and Compag 15 models 747111-001
Display enclosure for use in blue HP 15 and Compaq 15 models 750197-001
Display enclosure for use in purple HP 15 and Compaq 15 models 750198-001
Display enclosure for use in black HP 250 and HP 255 models 749015-001
Hinges (left and right) 747120-001
Webcam/microphone module 747144-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49).

5. Disconnect the WLAN module antenna cables from the WLAN module (see WLAN module on page 59).

6. Remove the following components:

° Service door (see Service door on page 56)

e  Top cover (see Top cover/keyboard on page 62)

To remove the display assembly:
1. Disengage the adhesive and disconnect the display panel cable (1) from the system board.
2. Remove the display panel cable from its routing path (2).

3. Release the wireless antenna cables from the clips (3) built into the base enclosure.

A CAUTION: Support the display assembly when removing the following screws. Failure to support the
display assembly can result in damage to the display assembly and other computer components.

4. Remove the five Phillips PM2.5x5.0 screws (1) that secure the display assembly to the computer.
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5. Remove the display assembly (2).
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If it is necessary to replace any of the display assembly subcomponents:
1. Toremove the display bezel:

a. Remove the two Mylar screw covers (1) and the two Phillips PM2.5x4.5 screws (2) that secure the
display bezel to the display assembly. The Mylar screw covers are included in the Rubber Kit, spare
part number 747133-001 for HP 15 and Compagqg 15 models, 756215-001 for HP 250 models, and
751418-001 for HP 255 models.

@NOTE: In this procedure, the display will NOT be connected to the computer, as shown in the
following image.

b. Flex theinside of the top edge (1), the left and right edges (2), and the bottom edge (3) of the
display bezel until the bezel disengages from the display enclosure.
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¢. Remove the display bezel (4).

E%V?NOTE: In this procedure, the display will NOT be connected to the computer, as shown in the
following image.

2. Toremove the webcam/microphone module:
a. Position the display assembly with the top edge toward you.

b. Disconnect the cable (1) from the module.
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¢. Remove the webcam/microphone module (2). (The module is attached to the display enclosure
with double-sided tape.)
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3. Toremove the display panel:

a. Remove the six Phillips PM2.5x4.0 screws (1) that secure the display panel to the enclosure, and
then rotate the display panel (2) onto the computer.

E%V?NOTE: In this procedure, the display will NOT be connected to the computer, as shown in the
following image.
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b. Onthe back of the display panel, release the adhesive strip (1) that secures the display panel cable
to the display panel, and then disconnect (2) and remove (3) the cable.

¢. Remove the panel from the display enclosure.

4. Toremove the display hinges:
a. Remove the six Phillips PM2.0x3.0 screws (1) that secure the display hinges to the display panel.
b. Remove the display hinges (2).
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5. Toremove the wireless antenna cables and transceivers:
a. Release the wireless antenna cables from the clips (1) built into the display enclosure.

b. Remove the wireless antenna cables and transceivers (2).

6. Toremove the display/webcam cable, release the webcam connector (1), webcam cable (2), and display
cable (3) from the routing path built into the display enclosure.

to

7. Ifreplacing the display enclosure, be sure that the other subcomponents (including the webcam/
microphone module, the antenna receivers, and all associated cables and hardware) are transferred to
the new enclosure.

Reverse this procedure to reassemble and install the display assembly.
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USB board

Description Spare part number

USB board (includes cable) 747126-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

° Service door (see Service door on page 56)

e  Top cover (see Top cover/keyboard on page 62)

To remove the USB board:

1.  Position the computer upright.

2. Release the ZIF connector (1) that secures the USB board cable to the system board.

3. Lift the cable to disengage the adhesive that secures it to the hard drive (2).

4. Remove the Phillips PM2.5x5.0 screw (3) that secures the USB board to the base enclosure.
5. Remove the USB board (4).

Reverse this procedure to install the USB board.
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Hard drive

E%?NOTE: The hard drive spare part kit does not include the hard drive cable or bracket.

Description Spare part number
1-GB, 5400-rpm, 2.5-in 676521-005
750-GB, 5400-rpm, 2.5-in 634250-005
500-GB, 5400-rpm, 2.5-in 669299-005
320-GB, 5400-rpm, 2.5-in (for use only in HP 250 models) 622643-005
Hard drive bracket 747117-001

Before removing the hard drive, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

. Service door (see Service door on page 56)

e  Top cover (see Top cover/keyboard on page 62)

To remove the hard drive:
1.  Lift the USB board cable to disengage the adhesive that secures it to the hard drive (1)
2. Remove the three Phillips PM2.5x4.5 screws (2) that secure the hard drive to the computer.

3.  Lift the hard drive (3) to gain access to the connector.
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4. Disconnect the connector from the hard drive (4).

5. Toremove the hard drive bracket, remove the four Phillips PM2.5x3.0 screws (1) that secure the
bracket to the hard drive.
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6. Remove the hard drive bracket from the hard drive (2).

Reverse this procedure to reassemble and install the hard drive.
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Optical drive connector

Description Spare part number

Optical drive connector 747119-001

Before removing the optical drive connector, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49), and then remove the following components:

° Service door (see Service door on page 56)

e  Top cover (see Top cover/keyboard on page 62)

Remove the optical drive connector:

1.
2.
3.

Disconnect the cable from the system board (1).
Insert a tool to pry up on each side of the connector (2) and push up to disengage it.

Remove the optical drive connector from the computer (3).

—~_

Reverse this procedure to install the optical drive connector.
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System board

E%?NOTE: The system board spare part kit includes replacement thermal materials.

E’%NOTE: Intel models come with removable processors. AMD models come with processors soldered to the

system board that cannot be removed or replaced.

Description Spare part number
System boards for use in models with Intel processors:

e  UMA graphics, Intel HM86 chipset, without Windows 8 747136-001
e  UMA graphics, Intel HM86 chipset, Windows 8 Standard 747136-501
e  UMA graphics, Intel HM86 chipset, Windows 8 Professional 747136-601
e  UMA graphics, Intel HM76 chipset, without Windows 8 747137-001
e  UMA graphics, Intel HM76 chipset, Windows 8 Standard 747137-501
e  UMA graphics, Intel HM76 chipset, Windows 8 Professional 747137-601
° Discrete graphics, Intel HM76 chipset, without Windows 8 748839-001
° Discrete graphics, Intel HM76 chipset, Windows 8 Standard 748839-501
° Discrete graphics, Intel HM76 chipset, Windows 8 Professional 748839-601
° UMA graphics, Pentium N3520 processor, without Windows 8 753099-001
° UMA graphics, Pentium N3520 processor, Windows 8 Standard 753099-501
° UMA graphics, Pentium N3520 processor, Windows 8 Professional 753099-601
e  UMA graphics, Pentium N3510 processor, without Windows 8 747138-001
e  UMA graphics, Pentium N3510 processor, Windows 8 Standard 747138-501
e  UMA graphics, Pentium N3510 processor, Windows 8 Professional 747138-601
e  UMA graphics, Celeron N2820 processor, without Windows 8 753100-001
e  UMA graphics, Celeron N2820 processor, Windows 8 Standard 753100-501
e  UMA graphics, Celeron N2820 processor, Windows 8 Professional 753100-601
e  UMA graphics, Celeron N2810 processor, without Windows 8 747139-001
e  UMA graphics, Celeron N2810 processor, Windows 8 Standard 747139-501
e  UMA graphics, Celeron N2810 processor, Windows 8 Professional 747139-601
System board for use in models with AMD A6-5200 processors and UMA graphics:

e  Without Windows 8 747150-001
e  Windows 8 Standard 747150-501
System board for use in models with AMD A4-5000 processors and UMA graphics:

e  Without Windows 8 747148-001
e  Windows 8 Standard 747148-501
System board for use only with models with an AMD E1-2100 processor and UMA graphics:

e  Without Windows 8 747149-001
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Description Spare part number

Windows 8 Standard 747149-501

System board for use only in models with an AMD A4-5000 processor and discrete graphics:

Without Windows 8 747151-001

Windows 8 Standard 747151-501

System board for use only in models with an AMD E2-3800 processor and discrete graphics:

Without Windows 8 748452-001

Windows 8 Standard 748452-501

System board for use only in models with an AMD E1-2100 processor and discrete graphics:

Without Windows 8 747152-001

Windows 8 Standard 747152-501

Before removing the system board, follow these steps:

1.

6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49).

Remove the following components:

e  Service door (see Service door on page 56)

e  Top cover (see Top cover/keyboard on page 62)

Disconnect the display cable from the system board (see Display assembly on page 71).

=?NOTE: When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

WLAN module (see WLAN module on page 59)

Memory module (see Memory module on page 61)

RTC battery (see RTC battery on page 104)

Fan/heat sink assembly (see Fan/heat sink assembly on page 90)

Processor (Intel only; see Processor on page 97)

r__*:"/?NOTE: AMD processors come soldered to the system board and cannot be removed or replaced.
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To remove the system board:

1.  Position the computer upside down, and then disconnect the hard drive connector cable (1) from the
system board.
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2. Position the computer upright, and then disconnect the following cables from the system board:
(2): Speaker cable
(3): USB board cable

(4): Optical drive connector cable

3. Remove the seven Phillips PM2.5x5.0 screws (1) that secure the system board to the base enclosure.

4. Lift the plastic tape from atop the fan (2).
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5. Lift the side opposite of the connectors of the system board (3), and then pull the system board away
from the connectors to remove it (4).

————— —

T
I
I
I
I
I
I
I

— e — — — — —
[ | — — — — —

Reverse this procedure to install the system board.
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Fan/heat sink assembly

@NOTE: The fan/heat sink assembly spare part kit includes replacement thermal materials.

?‘ NOTE: Bay Trail models support only a heat sink. Bay Trail models do not support a fan.

Description Spare part number

Models with Intel processors:

e UMA graphics and Intel HM76 chipset 747241-001
e UMA graphics and Intel HM86 chipset 747384-001
° UMA graphics and an Intel Bay Trail chipset 747243-001
° Discrete graphics and Intel HM76 chipset 747242-001

Models with AMD processors:

e  UMA graphics 747266-001

° Discrete graphics 747267-001

@’NOTE: To properly ventilate the computer, allow at least 7.6 cm (3.0 in) of clearance on the left side of the
computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor
and is designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced
through the ventilation grill located on the left side of the computer.

Before removing the fan/heat sink assembly, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

° Service door (see Service door on page 56)

° WLAN module (see WLAN module on page 59)

e  Top cover (see Top cover/keyboard on page 62)

e  System board (see System board on page 85)

@NOTE: The following procedure includes images for all available fan and heat sink options. Refer to the
image that matches your computer.

To remove the fan/heat sink assembly:
1.  Position the system board upside down.
2. Disconnect the fan cable (1) from the system board.

3. Loosen the screws on the heat sink (2) that secure the fan/heat sink assembly to the system board.
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Remove the fan/heat sink assembly (3).

Intel Bay Trail processor and UMA graphics

Remove the fan:

a. Disconnect the fan cable (1) from the system board.
b. Remove the fan from the clip on the system board (2).

¢. Remove the fan (3).

Intel processor and UMA graphics (not Bay Trail)

o
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Intel processor and discrete graphics (not Bay Trail)

(2]

Remove the heat sink:
a. Loosen the four Phillips screws that secure the heat sink to the system board (1).

b. Remove the heat sink (2) from the system board.

|
|
|
0
|
|
I
I
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AMD processor and discrete graphics

AMD processor and UMA graphics

?

The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board
components each time the heat sink is removed. Replacement thermal materials are included with the fan/
heat sink assembly, processor, and system board spare part kits.

Intel Bay Trail processor and UMA graphics
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e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it

Intel processor and discrete graphics (not Bay Trail)
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e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it
e  Thermal paste is used on the graphics subsystem chip (3) and the heat sink section (4) that services it

Intel processor and UMA graphics (not Bay Trail)
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e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it

AMD processor with discrete graphics

|

e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it
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AMD processor with UMA graphics

i

e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it

Reverse this procedure to reassemble and install the fan/heat sink assembly.

Processor

E‘%NOTE: This section applies only to computer models equipped with an Intel processor. AMD processors
come soldered to the system board and cannot be removed or replaced.

E”%NOTE: The processor spare part kit includes replacement thermal materials.

Description Spare part number
Intel Core i5 3230M processor (2.60-GHz 3.0-MB L3 cache, dual core, 35 W) 711903-002
Intel Core i3 4000M processor (2.40-GHz, 3.0-MB L3 cache, dual core) 737327-001
Intel Core i3 3110M processor (2.40-GHz, 3.0-MB L3 cache, dual core) 682417-001
Intel Pentium 2020M processor (2.40-GHz, 2.0-MB L3 cache, dual core, 35 W) 700628-001
Intel Celeron 1000M processor (1.8-GHz, 2.0-MB L3 cache, dual core, 35 W) 713162-001

Before removing the processor, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

Service door (see Service door on page 56)

WLAN module (see WLAN module on page 59)

Top cover (see Top cover/keyboard on page 62)

System board (see System board on page 85)

Fan/heat sink assembly (see Fan/heat sink assembly on page 90)

To remove the processor:

1. Position the system board upside down.

2. Use aflat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise (2) until you hear a click.

3.  Lift the processor (3) straight up, and then remove it.

E%?NOTE: The gold triangle (4) on the processor must be aligned with the triangle icon embossed on the
processor socket when you install the processor.

3

-

Reverse this procedure to install the processor.
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Power connector cable

Description Spare part number

Power connector cable 747116-001

Before removing the power connector cable, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

. Service door (see Service door on page 56)

° WLAN module (see WLAN module on page 59)

e  Top cover (see Top cover/keyboard on page 62)

e  System board (see System board on page 85)

To remove the power connector cable:
1.  Position the system board upside down.
2. Disconnect the power connector cable (1) from the system board.

3. Release the power connector cable from the clips (2) built into the fan.
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4. Remove the power connector cable (3).

Reverse this procedure to install the power connector cable.
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Card reader board

Description Spare part number

Card reader board (includes cable) 747129-001

Before removing the card reader board, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 49), and then remove the following components:

. Service door (see Service door on page 56)

° WLAN module (see WLAN module on page 59)

e  Top cover (see Top cover/keyboard on page 62)

e  System board (see System board on page 85)

Remove the card reader board:
1.  Position the system board upside down.
2. Disconnect the cable from the system board (1).

3. Remove the two Phillips PM2.5x4.0 screws (2) that secure the card reader board to the system board.

Component replacement procedures 101



4. Remove the card reader board (3).

Reverse this procedure to install the card reader board.
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Speakers

Description

Spare part number

Speakers (includes left and right speakers and cable) 747135-001

Before removing the speakers, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49), and then remove the following components:

Service door (see Service door on page 56)

WLAN module (see WLAN module on page 59)

Top cover (see Top cover/keyboard on page 62)

USB board (see USB board on page 80)

Display assembly (see Display assembly on page 71)

System board (see System board on page 85)

To remove the speakers:

1.
2.

Remove the four Phillips PM2.5x4.0 screws (1) that secure the speakers to the computer.

Remove the speaker cable from the clips built into the computer chassis (2).
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3.

Remove the speakers (3).

Reverse this procedure to install the speakers.

RTC battery
Description Spare part number
RTC battery 747132-001

Before removing the RTC battery, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49), and then remove the following components:

e  Service door (see Service door on page 56)

e  WLAN module (see WLAN module on page 59)

Top cover (see Top cover/keyboard on page 62)

System board (see System board on page 85)
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To remove the RTC battery:

1.  Position the system board upside down.

2. Disconnect the battery cable from the system board (1), and then lift the battery up and off the system

board (2).

o

-,

A

S

Reverse this procedure to install the RTC battery.
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Hard drive connector

Description

Spare part number

Hard drive connector 747118-001

Before removing the hard drive connector, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49), and then remove the following components:

Service door (see Service door on page 56)

WLAN module (see WLAN module on page 59)

Hard drive (see Hard drive on page 81)

Top cover (see Top cover/keyboard on page 62)

System board (see System board on page 85)

Remove the hard drive connector:

1.

Remove the cable from the clips built into the computer chassis (1).
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2. Remove the hard drive connector (2).

Reverse this procedure to install the hard drive connector.
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Weight

Before removing the weight, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 49), and then remove the following components:

Service door (see Service door on page 56)

WLAN module (see WLAN module on page 59)

Hard drive (see Hard drive on page 81)

Top cover (see Top cover/keyboard on page 62)

USB board (see USB board on page 80)

Display assembly (see Display assembly on page 71)

System board (see System board on page 85)

Remove the weight:

1.
2.

Remove the two Phillips PM2.5x6.5 screws (1) that secure the weight to the computer.

Remove the weight from the computer (2).

Reverse this procedure to install the weight.

108 Chapter4 Removal and replacement procedures



5 Using Setup Utility (BIOS) and HP PC
Hardware Diagnostics (UEFI) in Windows 8

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and output
devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility (BIOS)
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.

Starting Setup Utility (BI10S)

To start Setup Utility (BIOS), turn on or restart the computer, quickly press esc, and then press f10.

E‘%NOTE: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the computer
from operating properly.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPags.
Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if
you are already in Windows) or by using Setup Utility (BIOS).

1.  Start Setup Utility (BIOS) (see Starting Setup Utility (BIOS) on page 109).
2. Usethe arrow keys to select Main.

3. To exit Setup Utility (BIOS) without saving your changes, use the arrow keys to select Exit, select Exit
Discarding Changes, and then press enter.

4. Select Yes.
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Downloading a BIOS update

A CAUTION: Toreduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter.
Do not download or install a BIOS update while the computer is running on battery power, docked in an
optional docking device, or connected to an optional power source. During the download and installation,
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1.

From the Start screen, type hp support assistant,and then select the HP Support Assistant
app.

Click Updates and tune-ups, and then click Check for HP updates now.
Follow the on-screen instructions.
At the download area, follow these steps:

a. ldentify the most recent BIOS update and compare it to the BIOS version currently installed on
your computer. If the update is more recent than your BIOS, make a note of the date, name, or
other identifier. You may need this information to locate the update later, after it has been
downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard
drive where the BIOS update is downloaded. You will need to access this path when you are ready
to install the update.

E‘%NOTE: If you connect your computer to a network, consult the network administrator before installing

any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:

1.
2.
3.

5.

From the Start screen, type £i1e, and then select File Explorer.
Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

Complete the installation by following the on-screen instructions.

@NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.
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Using HP PC Hardware Diagnostics (UEFI)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run
diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs outside
the operating system so that it can isolate hardware failures from issues that are caused by the operating
system or other software components.

To start HP PC Hardware Diagnostics UEFI:
1.  Turnonor restart the computer, quickly press esc, and then press f2.
The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

E%?NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 111.

b. Harddrive
c. BIOS

2. When the diagnostic tool opens, click the type of diagnostic test you want to run, and then follow the
on-screen instructions.

E’%NOTE: If you need to stop a diagnostic test, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

E”%NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

1. Goto http://www.hp.com.

2. Click Support & Drivers, and then click the Drivers & Downloads tab.
3. Enter the product name in the text box, and then click Go.
4. Select your computer model, and then select your operating system.
5. Inthe Diagnostic section, click HP UEFI Support Environment.

—or—

Click Download, and then select Run.
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6 Using Setup Utility (BIOS) and System
Diagnostics in Windows 7

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and output
devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility (BIOS)
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.

Starting Setup Utility (BI10S)

To start Setup Utility (BIOS), follow these steps:

1.  Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Setup Utility (BIOS).

Information about how to navigate in Setup Utility (BIOS) is located at the bottom of the screen.

E%?NOTE: Use extreme care when making changes in Setup Utility (BIOS). Errors can prevent the computer
from operating properly.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPags.
Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on
the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn+esc (if
you are already in Windows) or by using Setup Utility (BIOS).

1.  Start Setup Utility (BIOS).
2. Usethearrow keys to select Main.

3. Toexit Setup Utility (BIOS) without saving your changes, use the tab key and the arrow keys to select
Exit > Exit Discarding Changes, and then press enter.
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Downloading a BIOS update

A CAUTION: Toreduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter.
Do not download or install a BIOS update while the computer is running on battery power, docked in an
optional docking device, or connected to an optional power source. During the download and installation,
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1.
2.

Select Start > Help and Support > Maintain.

Follow the on-screen instructions to identify your computer and access the BIOS update you want to
download.

At the download area, follow these steps:

a. ldentify the BIOS update that is later than the BIOS version currently installed on your computer.
Make a note of the date, name, or other identifier. You may need this information to locate the
update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is downloaded.
You will need to access this path when you are ready to install the update.

E’%NOTE: If you connect your computer to a network, consult the network administrator before installing

any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1.
2.
3.

5.

Open Windows Explorer by selecting Start > Computer.
Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

Complete the installation by following the on-screen instructions.

@NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.
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Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is functioning
properly.
To start System Diagnostics:

1.  Turnon or restart the computer. While the “Press the ESC key for Startup Menu” message is displayed in
the lower-left corner of the screen, press esc. When the Startup Menu is displayed, press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

@NOTE: If you need to stop a diagnostics test while it is running, press esc.
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7 Computer Setup (BIOS) and Advanced
System Diagnostics in SUSE Linux

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of peripherals installed, the startup sequence of the computer, and the
amount of system and extended memory.

E‘%NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup

E/?NOTE An external keyboard or mouse connected to a USB port can be used with Computer Setup only if
USB legacy support is enabled.

To start Computer Setup, follow these steps:

1.  Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Pressf10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1.  Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e  Toselect a menu ora menuitem, use the tab key and the keyboard arrow keys and then press
enter, or use a pointing device to click the item.

e  Toscrollup and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and then
follow the on-screen instructions.

@NOTE You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard
to navigate and make selections in Computer Setup.

2. Press 10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

=¥ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1.

w kW N

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.
Follow the on-screen instructions.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow
the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

@NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on
the computer, you need to know the version of the system BIOS currently installed.
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BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1.  Start Computer Setup.
2. Useapointing device or the arrow keys to select File > System Information.

3. Toexit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press enter.

%?NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing the esc
key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and
then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

A CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter.
Do not download or install a BIOS update while the computer is running on battery power, docked in an
optional docking device, or connected to an optional power source. During the download and installation,
follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Openyour web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to
download.

3. Click the option for software and driver downloads, type your computer model number in the product
box, and then press enter. Follow the on-screen instructions to identify your computer and access the
BIOS update you want to download.

4. Click your specific product from the models listed.
5. Click the appropriate operating system.
6. Goto the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

E%?NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start the
computer.

e  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.
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e  Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all data in
every sector of the hard drive. If the test detects a damaged sector, it attempts to move the datato a
good sector.

e  Memory test—This test analyzes the physical condition of the memory modules. If it reports an error,
replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary. If
the battery fails the test, contact support to report the issue and purchase a replacement battery.

e  System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests on
memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1.  Turnon or restart the computer. While the “Press the ESC key for Startup Menu” message is displayed in
the lower-left corner of the screen, press esc. When the Startup Menu is displayed, press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

= NOTE: If you need to stop a diagnostics test while it is running, press esc.
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8 Specifications

Computer specifications

Metric u.s.
Dimensions (touch models)
Depth 25.2cm 9.2in
Width 37.8cm 14.88in
Height

2.98 cm 1.17in
Touch

2.81cm 1.11in
Non-touch
Weight

2.75kg 6.17 b
Touch

2.25kg 5.511b
Non-touch
Input power
Operating voltage and current 18.5Vdc@3.5A0r19.5Vdc@3.33A-65W

19Vdc@4.74A0r19.5Vdc @ 4.62A-90W
Temperature
Operating 5°Cto 35°C 41°F to 95°F
Nonoperating -20°Cto 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15mto0 3,048 m -50 ft to 10,000 ft

Nonoperating -15mt0 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this range of
temperatures.
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39.6-cm (15.6-in) display specifications

Metric u.s.
Active diagonal size 39.6-cm 15.6-in
Resolution 1600x900 (HD+)
Active area 309.399x173.952
PPI 112
Surface treatment Anti-glare

Contrast ratio

300:1 (typical)

Response time 8ms

Brightness 200 nits (typical)
Viewing angle SVA

Backlight LED

Luminance uniformity @ 13 points

1.4 (typ), 1.6 (max)

Lifetime (1/2 luminance)

12,000 hours

Color coordinate (white)

(0.313,0.329)

Color tolerance (White) +/-0.02
Color tolerance (W, R, G, B) +/-0.03
Color gamut 45% typical
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Hard drive specifications

1-TB* 750-GB* 500-GB* 320-GB*
(9.5 mm) (7.0mm) (9.5 mm)

Dimensions
Height 9.5 mm 9.5 mm 7.0mmor 9.5 mm 7.0 mm or 9.5 mm
Length 100.4 mm 100.4 mm 100.6 mm 100.4 mm
Width 69.9 mm 69.9 mm 70.1 mm 69.9 mm
Weight 115.0g 115.0g 92.0g 98.8¢
Interface type SATA SATA SATA SATA
Transfer rate
Synchronous (maximum) 300 MB/sec 300 MB/sec 300 MB/sec 300 MB/sec
Security ATA security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 1.4ms 1.5ms 3ms 3ms
Average (read/write) 10 ms 11 ms 13 ms 13 ms
Maximum 12ms 14 ms 24 ms 24 ms
Logical blocks 1,938,921,461 1,465,149,168 1,048,576,000 625,142,448
Disk rotational speed 5400 rpm 5400 rpm 5400 rpm 5400 rpm
Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD+RW SuperMulti DL Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD- ~ CD-R and CD-RW

ROM XA, MIXED MODE €D, CD-I, CD-I Bridge (Photo-

(D, Video CD), Multisession CD (Photo-CD, CD- DVD+R, DVD+RW, DVD-R, DVD-RW,
EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-RAM

DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-

R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Center hole diameter

1.5cm (0.59in)

Disc diameter

Standard disc

12cm (4.72in)

Mini disc

8cm(3.15in)

Disc thickness

1.2 mm (0.047 in)

Track pitch 0.74 ym

Access time cD DVD
Random <175ms <230 ms
Full stroke <285ms <335ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer 2MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8XDVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

<15 seconds

Stop time

< 6 seconds
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9 Backing up, restoring, and recovering in
Windows 8

This chapter provides information about the following processes:
e  (reating recovery media and backups

e  Restoring and recovering your system

Creating recovery media and backups

1.  After you successfully set up the computer, create HP Recovery media. This step creates a backup of the
HP Recovery partition on the computer. The backup can be used to reinstall the original operating
system in cases where the hard drive is corrupted or has been replaced.

HP Recovery media you create will provide the following recovery options:

e  System Recovery—Reinstalls the original operating system and the programs that were installed
at the factory.

e  Minimized Image Recovery—Reinstalls the operating system and all hardware-related drivers and
software, but not other software applications.

e  Factory Reset—Restores the computer to its original factory state by deleting all information
from the hard drive and re-creating the partitions. Then it reinstalls the operating system and the
software that was installed at the factory.

See Creating HP Recovery media on page 125.

2. Usethe Windows tools to create system restore points and create backups of personal information. For
more information and steps, see Help and Support. From the Start screen, type help, and then select
Help and Support.

Creating HP Recovery media

HP Recovery Manager is a software program that offers a way to create recovery media after you
successfully set up the computer. HP Recovery media can be used to perform system recovery if the hard
drive becomes corrupted. System recovery reinstalls the original operating system and the software
programs installed at the factory, and then configures the settings for the programs. HP Recovery media can
also be used to customize the system or restore the factory image if you replace the hard drive.

e  Only one set of HP Recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

e  HP Recovery Manager examines the computer and determines the required storage capacity for the
blank USB flash drive or the number of blank DVD discs that will be required.

e  Tocreaterecovery discs, your computer must have an optical drive with DVD writer capability, and you
must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use rewritable
discs such as CD+RW, DVD+RW, double-layer DVD+RW, or BD-RE (rewritable Blu-ray) discs; they are not
compatible with HP Recovery Manager software. Or instead you can use a high-quality blank USB flash
drive.
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If your computer does not include an integrated optical drive with DVD writer capability, but you would
like to create DVD recovery media, you can use an external optical drive (purchased separately) to
create recovery discs, or you can obtain recovery discs for your computer from support. See the
Worldwide Telephone Numbers booklet included with the computer. You can also find contact
information from the HP website. Go to http://www.hp.com/support, select your country or region, and
follow the on-screen instructions. If you use an external optical drive, it must be connected directly to a
USB port on the computer; the drive cannot be connected to a USB port on an external device, such as a
USB hub.

Be sure that the computer is connected to AC power before you begin creating the recovery media.
The creation process can take up to an hour or more. Do not interrupt the creation process.

If necessary, you can exit the program before you have finished creating all of the recovery DVDs. HP
Recovery Manager will finish burning the current DVD. The next time you start HP Recovery Manager,
you will be prompted to continue, and the remaining discs will be burned.

To create HP Recovery media:

i»IMPORTANT: For tablets, connect to the keyboard dock before beginning these steps (select models only).

1.
2.

From the Start screen, type recovery, and then select HP Recovery Manager.

Select Recovery Media Creation, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 127.

Restore and recovery

There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:

Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information and steps, see Help and Support. From the Start
screen, type help, and then select Help and Support.

If you need to correct a problem with a preinstalled application or driver, use the Drivers and
Applications Reinstall option of HP Recovery Manager to reinstall the individual application or driver.

From the Start screen, type recovery, select HP Recovery Manager, select Drivers and Applications
Reinstall, and then follow the on-screen instructions.

If you want to reset your computer using a minimized image, you can choose the HP Minimized Image
Recovery option from the HP Recovery partition (select models only) or HP Recovery media. Minimized
Image Recovery installs only drivers and hardware-enabling applications. Other applications included in
the image continue to be available for installation through the Drivers and Applications Reinstall option
in HP Recovery Manager.

For more information, see Recovering using HP Recovery Manager on page 127.

If you want to recover the computer's original factory partitioning and content, you can choose the
System Recovery option from the HP Recovery partition (select models only) or use the HP Recovery
media that you have created. For more information, see Recovering using HP Recovery Manager

on page 127. If you have not already created recovery media, see Creating HP Recovery media

on page 125.
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e If you havereplaced the hard drive, you can use the Factory Reset option of HP Recovery media to
restore the factory image to the replacement drive. For more information, see Recovering using HP
Recovery Manager on page 127.

e |f you wish to remove the recovery partition to reclaim hard drive space, HP Recovery Manager offers
the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition on page 128.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the
HP Recovery media that you created or by using the HP Recovery partition (select models only). If you have
not already created recovery media, see Creating HP Recovery media on page 125.

Using HP Recovery media, you can choose from one of the following recovery options:

e  System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

e  Minimized Image Recovery (select models only)—Reinstalls the operating system and all hardware-
related drivers and software, but not other software applications.

e  Factory Reset—Restores the computer to its original factory state by deleting all information from the
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that
was installed at the factory.

The HP Recovery partition (select models only) allows System Recovery and Minimized Image Recovery.

What you need to know

e  HP Recovery Manager recovers only software that was installed at the factory. For software not
provided with this computer, you must either download the software from the manufacturer's website
or reinstall the software from the media provided by the manufacturer.

e  Recovery through HP Recovery Manager should be used as a final attempt to correct computer issues.

e  HP Recovery media must be used if the computer hard drive fails. If you have not already created
recovery media, see Creating HP Recovery media on page 125.

e Touse the Factory Reset option, you must use HP Recovery media. If you have not already created
recovery media, see Creating HP Recovery media on page 125.

e |f the HP Recovery media does not work, you can obtain recovery media for your system from support.
See the Worldwide Telephone Numbers booklet included with the computer. You can also find contact
information from the HP website. Go to http://www.hp.com/support, select your country or region, and
follow the on-screen instructions.

E'%IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you wish to retain.

Using the HP Recovery partition (select models only)

The HP Recovery partition (select models only) allows you to perform a system recovery or minimized image
recovery without the need for recovery discs or a recovery USB flash drive. This type of recovery can only be
used if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:
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i IMPORTANT: For tablets, connect to the keyboard dock before beginning these steps (select models only).

1.  Press f11 while the computer boots.

—or-

Press and hold f11 as you press the power button.
2. Choose your keyboard layout.
3. Select Troubleshoot from the boot options menu.

4. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media that you created, and then restart the computer.

%/%"NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 128.

3. Follow the on-screen instructions.

Changing the computer boot order

If computer does not restart in HP Recovery Manager, you can change the computer boot order, which is the
order of devices listed in BIOS where the computer looks for startup information. You can change the
selection for an optical drive or a USB flash drive.

To change the boot order:

1. Insert the HP Recovery media you created.

2 Restart the computer, quickly press esc, and then press f9 for boot options.
3. Select the optical drive or USB flash drive you want to boot from.
4

Follow the on-screen instructions.

Removing the HP Recovery partition

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

@IMPORTANT: After you remove the HP Recovery partition, you can no longer use the Windows Refresh
option, the Windows option to remove everything and reinstall Windows, or the HP Recovery Manager option.
So before you remove the Recovery partition, create HP Recovery media; see Creating HP Recovery media
on page 125.

Follow these steps to remove the HP Recovery partition:
1. From the Start screen, type recovery, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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10 Backing up, restoring, and recoveringin
Windows 7

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and retrieve it if ever needed.

Creating backups
1. Use HP Recovery Manager to create recovery media immediately after you set up the working
computer.

2. Asyouadd hardware and software programs, create system restore points.
3. Asyou add photos, video, music, and other personal files, create a backup of your system and personal
information.

Creating recovery media to recover the original system

After you successfully set up the computer, you should create recovery discs or a recovery flash drive using
HP Recovery Manager. You will need these recovery discs or recovery flash drive to perform a system
recovery should the hard drive become corrupted. A system recovery reinstalls the original operating system,
and then configures the settings for the default programs.

What you need to know

e  Only one set of recovery media can be created. Handle these recovery tools carefully, and keep them in
asafe place.

e  HP Recovery Manager examines the computer and determines the required storage capacity for the
flash drive or the number of blank DVD discs that will be required.

Use DVD-R, DVD+R, DVD-R DL, DVD+R DL discs or a flash drive. Do not use rewriteable discs such as CD
+RW, DVD+RW, double-layer DVD+RW, and BD-RE (rewritable Blu-ray) discs; they are not compatible
with HP Recovery Manager software.

e |f your computer does not include an integrated optical drive, you can use an optional external optical
drive (purchased separately) to create recovery discs, or you can obtain recovery discs for your
computer from the HP website. If you use an external optical drive, it must be connected directly to a
USB port on the computer, not to a USB port on an external device, such as a USB hub.

e  Besure that the computer is connected to AC power before you begin creating the recovery media.
e  The creation process can take up to an hour or more. Do not interrupt the creation process.
e  Store therecovery mediain a safe location, separate from the computer.

e If necessary, you can exit the program before you have finished creating the recovery media. The next
time you open HP Recovery Manager, you will be prompted to continue the process.
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Creating the recovery media

1. Select Start and type recovery in the search field. Select Recovery Manager from the list. Allow the
action to continue, if prompted.

2. Click Recovery Media Creation.
3. Follow the on-screen instructions to continue.

To recover, see Recovering the original system using HP Recovery Manager on page 132.

Creating system restore points

A system restore point is a snapshot of certain hard drive contents saved by Windows System Restore at a
specific time. A restore point contains information such as registry settings that Windows uses. Restoring to
a previous restore point allows you to reverse changes that have been made to the system since the restore
point was created.

Restoring to an earlier system restore point does not affect data files saved or emails created since the last
restore point, but it does affect software you may have installed.

For example, if you download a photo from a digital camera and then restore the computer to the state it was
on the previous day, the photo remains on the computer.

However, if you install photo viewing software and then restore your computer to the state it was on the
previous day, the software will be uninstalled, and you won't be able to use it.

What you need to know
e If yourestore to a restore point and then change your mind, you can undo the restoration.
e  Youshould create system restore points:
° Before you add or change software or hardware
° Periodically, whenever the computer is running normally

e  System Restore also saves shadow copies of files that have been changed since the last restore point
was created. For more information about using shadow copies to restore, see Help and Support.

Creating a system restore point
1. Select Start > Control Panel > System and Security > System.
2. Inthe left pane, click System Protection.
3. Click the System Protection tab.
4. Click Create, and follow the on-screen instructions.

To restore, see Restoring to a previous system restore point on page 132.

Backing up system and personal information

Your computer stores information that is important to you, such as files, emails, and photos, and you will
want to keep that information even if you download a virus or the system stops working properly. How
completely you are able to recover your files depends on how recent your backup is. As you add new
software and data files, you should create backups on a regular basis.
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Tips for a successful backup

Number backup discs before inserting them into the optical drive.

Store personal files in the Documents, Music, Pictures, and Videos libraries, and back up these folders
periodically.

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.
The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1.
2.

4.

Display the screen you want to save.

Copy the screen image:

To copy only the active window, press alt+prt sc.
To copy the entire screen, press prt sc.

Open a word-processing document or graphics editing program, and then select Edit > Paste. The
screen image is added to the document.

Save and print the document.

What you need to know

You can back up your information to an optional external hard drive, a flash drive, a network drive, or
discs.

Connect the computer to AC power during backups.

Allow enough time for the backup. Depending on files sizes, it may take more than an hour.
Verify the amount of free space on your backup storage device before you back up.

You should back up:

° Before adding or changing software or hardware.

° Before the computer is repaired or restored.

° On a regular schedule to be sure you have recent copies of personal information.

° After you add many files—for example, if you saved videos from a birthday party.

° Before using antivirus software to remove a malicious program.

° After adding information that is hard to replace, such as pictures, videos, music, project files, or
datarecords.

Creating a backup using Windows Backup and Restore

Windows allows you to back up files using Windows Backup and Restore. You can select the level you want to
back up, from individual folders to drives. The backups are compressed to save space. To back up:

1.
2.

Select Start > Control Panel > System and Security > Backup and Restore.

Follow the on-screen instructions to schedule and create a backup.

@NOTE: Windows includes the User Account Control feature to improve the security of the computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. See Help and Support for more information.

To restore, see Restoring specific files using Windows Backup and Restore on page 132.
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Restore and recovery

Restoring to a previous system restore point

Sometimes installing a software program causes your computer or Windows to behave unpredictably.
Usually uninstalling the software fixes the problems. If uninstalling does not fix the problems, you can
restore the computer to a previous system restore point (created at an earlier date and time).

To restore to a previous system restore point, when the computer was running correctly:
1.  Select Start > Control Panel > System and Security > System.

2 In the left pane, click System Protection.

3.  Click the System Protection tab.
4

Click System Restore, and follow the on-screen instructions.

Restoring specific files

If files are accidentally deleted from the hard disk and they can no longer be restored from the Recycle Bin, or
if files become corrupt, restoring specific files is useful. Restoring specific files is also useful if you ever
choose to recover the original system using HP Recovery Manager. You can only restore specific files that you
have backed up before.

Restoring specific files using Windows Backup and Restore
Windows allows you to restore files that were backed up using Windows Backup and Restore:
1.  Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to restore your backup.

E/%"NOTE: Windows includes the User Account Control feature to improve the security of the computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. See Help and Support for more information.

Recovering the original system using HP Recovery Manager

HP Recovery Manager software allows you to repair or recover the computer to its original factory state.

What you need to know

e  HP Recovery Manager recovers only software that was installed at the factory. For software not
provided with this computer, you must either download the software from the manufacturer's website
or reinstall the software from the disc provided by the manufacturer.

e Asystemrecovery should be used as a final attempt to correct computer issues. If you have not already
tried restore points (see Restoring to a previous system restore point on page 132) and partial restores
(see Restoring specific files on page 132), try them before using HP Recovery Manager to recover your
system.

e  Asystemrecovery must be performed if the computer hard drive fails or if all attempts to correct any
functional computer issues fail.
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° If the recovery media do not work, you can obtain recovery discs for your system from the HP website.

e  The Minimized Image Recovery option is recommended for advanced users only. All hardware-related
drivers and software are re-installed, but other software applications are not. Do not interrupt the
process until it is complete, otherwise the recovery will fail.

Recovering using HP Recovery partition (select models only)

The HP Recovery partition (select models only), allows you to restore your system without the need for
recovery discs or a recovery flash drive. This type of recovery can only be used if the hard drive is still
working.

To check for the presence of a recovery partition, select Start, right-click Computer then select Manage >
Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.

E‘%NOTE: Recovery discs have been included if your computer did not ship with a recovery partition.

1. Access HP Recovery Manager in either of the following ways:
e  Select Start and type recovery inthe search field. Select Recovery Manager from the list.

e  Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then press f11 while the “F11 (System
Recovery)” message is displayed on the screen.

2. Click System Recovery in the HP Recovery Manager window.

3. Follow the on-screen instructions.

Recovering using the recovery media
1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external optical
drive, and then restart the computer.

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

?*‘ NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 133.

3. Pressf9 at system bootup.
4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.
Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press f9 for boot options.

3. Select Internal CD/DVD ROM Drive from the boot options window.
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To change the boot order for a recovery flash drive:

1. Insert the flash drive into a USB port.

2 Restart the computer.

3. Press esc while the computer is restarting, and then press f9 for boot options.
4

Select the flash drive from the boot options window.
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11 Backup and Recovery in SUSE Linux

Recovery after a system failure is as good as your most recent backup. As you add new software and data
files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up your
system at the following times:

e  Atregularly scheduled times

e  Before the computer is repaired or restored

e  Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click Backup my home
directory.

2. (Click Storage Destination Location, and then select a location to back up your information.
3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled time.

To immediately back up your information, click the Backup Now check box.

=7 NOTE: Before you back up your information, be sure you have designated a location to save the
backup files.

4. C(lick Save and Backup to start the backup and to save the backup settings.
To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
4. Select the Optical Disk option.
5

Under Restore Point, click the time and date of the backup.

E/?’NOTE: If multiple backups have been performed, click Use the latest version to restore the latest
version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image Restore DVD, using an installed or an external DVDzRW optical drive. You can also restore the
computer to its factory condition from the HP dedicated recovery partition on the hard drive.
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A CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The recovery tool
reinstalls the original operating system and HP programs and drivers that were installed at the factory.
Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be
restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery disc. To
create the recovery disc:

= NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a system failure.

1. Select Computer > More Applications.

2. Inthe left pane, click Tools, and then click Create HP Factory Image Restore DVD in the right pane.
3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2 Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. Asthe computer is restarting, press f9 to open the Computer Setup boot option menu.
4

Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot menu, and
then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?

6. Follow the on-screen instructions.

@NOTE: You can also restore the computer from the partition by restarting the computer, and then pressing
the f11 key.

If you are unable to boot (start up) your computer from the hard drive partition with the primary operating
system or from the recovery partition, and you did not create a system recovery disc, you must purchase a
SUSE Linux Enterprise Desktop Operating System DVD to reinstall the operating system. For additional
information, see the Worldwide Telephone Numbers booklet.
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12

Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in industry-
standards based HP Business Notebook PC systems and provide general instructions for restoring
nonvolatile memory that can contain personal data after the system has been powered off and the hard drive
has been removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR
memory. The amount of nonvolatile memory present in the system depends upon the system configuration.
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally
shipped from HP assuming that no subsequent modifications have been made to the system and assuming
that no applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system,
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain
in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the
nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed
in the Maintenance & Service Guides available for HP PC products available on the product support pages at
www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal data.
Restoring or re-programming nonvolatile memory that does not store personal data is neither
necessary nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the
bottom of the display, or press the ESC key to display the start up menu, then press F10. If the
system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.
¢. Select the System Configuration menu, then Restore Security Defaults.

d. Ifanasset or ownership tagis set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select the tag that has been set. Press the spacebar once to clear the
tag, then press Enter to return to the prior menu.

e. IfaDriveLock password is set, select the Security menu, scroll down to DriveLock, then select
DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing
master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this
procedure if more than one hard drive has a DriveLock password.

f. If an Automatic DriveLock password is set, select the Security menu, scroll down to Automatic
DriveLock, then select the desired hard drive and disable protection. Repeat this procedure if
more than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the warning
message.

h. Select the File menu, then Save Changes and Exit.

i.  Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint sensor,
one or two prompts will appear. One to clear the TPM and the other to Reset Fingerprint Sensor;
press F1 to accept or F2 to reject.

If the HP notebook model number includes Intel® Centrino with VPro™, reboot the PC and enter
BIOS Setup by pressing F10 when prompted. Select System Configuration, then AMT Options.
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2.

Then select Un-configure AMT on next boot. Select Save then Yes. Select the File menu, and then
select Save Changes and Exit. Reboot the system and confirm that you want to un-configure AMT.

If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to de-activate
it.

If the optional Absolute® Software Computrace® management and tracking service was activated
on the notebook PC, contact the provider to deactivate it.

Remove all power and system batteries for at least 24 hours.

Remove and retain the storage drive or clear the contents of the drive.

lﬂi_f%

Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that,
ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when
prompted near the bottom of the display, or press ESC to display the start up menu, then press
F10. Select the Security menu and scroll down to the Utilities menu. Select Disk Sanitizer and
select the desired drive. For a higher level of protection, select Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard drive
capacity.

Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third
party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by
powering on the system and pressing F10 when prompted near the bottom of the display. Select
the Security menu and scroll down to the Utilities menu. Select Secure Erase and select the
desired hard drive.

Non-volatile memory usage

Non Volatile Amount Does this Does this What is the How is data input into this How is this memory write
Memory Type (Size) memory memory purpose of this memory? protected?
store retain data memory?
customer when power
data? is removed?
HP Sure Start 2MB No Yes Only in Data cannot be written to this  Protected by the HP Sure
platforms that  device via the host processor.  Start Embedded
support Sure The content is managed Controller.
Start to provide  solely by the HP Sure Start
protected Embedded Controller.
backup of
critical System
BIOS code, EC
firmware, and
critical PC
configuration
data.
Real Time Clock 256 Bytes No Yes Stores system Using the F10 Setup utility or ~ This memory is not write-

(RTC) battery
backed-up CMOS
configuration
memory (CMOS)

date and time
and limited
keyboard
controller data.

changing the Microsoft®
Windows® date & time.

protected. HP
recommends password
protecting the F10 Setup
utility.
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Non Volatile Amount Does this Does this What is the How is data input into this How is this memory write
Memory Type (Size) memory memory purpose of this memory? protected?

store retain data memory?

customer when power

data? is removed?

Controller (NIC) 64 Kbytes No Yes Store NIC Using a utility from the NIC A utility is required to

EEPROM (not customer configuration vendor that can be run from write data to this memory
accessible) and NIC DOS. and is available from NIC

firmware. vendor. Writing data to
this ROMin an
inappropriate manner will
render the NIC non-
functional.

Keyboard ROM 64 Kbytes No Yes Stores firmware Programmed at the factory. A utility is required for
(not customer code (keyboard, Code is updated when the writing data to this
accessible) mouse, & system BIOS is updated. memory and is available

battery on the HP website. Writing

management). data to this ROMin an
inappropriate manner can
render the PC non-
functional.

DIMM Serial 256 Bytesper No Yes Stores memory  Programmed by the memory  Data cannot be written to

Presence Detect memory module vendor. this memory when the

(SPD) module, 128 information. module is installed in a

configuration data Bytes PC. The specific write
programmabl protection method varies
e (not by memory vendor.
customer
accessible)

System BIOS 4to5MBytes VYes Yes Store system System BIOS code is A utility is required for

BIOS code and programmed at the factory. writing data to this
PC Code is updated when the memory and is available
configuration system BIOS is updated. on the HP website. Writing
data. Configuration data and data to this ROM in an
settings are input using the inappropriate manner can
F10 setup utility or a custom render the PC non-
utility. functional.

Intel Management 1.5 or 5MByte Yes Yes Stores Management Engine Code is The Intel chipset is

Engine Firmware Management programmed at the factory. configured to enforce HW

(present only in Engine Code, Code is updated via Intel protection to block all

models endingina Settings, secure firmware update direct read/write access

‘p’ or ‘w’ or with Provisioning utility. Unique Provisioning to this area. An Intel

Intel Centrino Pro Data and iAMT Data can be entered at the utility is required for

technology) third party data  factory or by an administrator updating the firmware.

store. using the Management Engine  Only firmware updates
(MEBx) setup utility. The third  digitally signed by Intel
party data store contents can  can be applied using this
populated by a remote utility.
management console or local
applications registered by an
administrator to have access
to the space.

Bluetooth flash 2Mbit No Yes Stores Programmed at the factory. A utility is required for
Bluetooth Tools for writing data to this writing data to this

configuration
and firmware.

memory are not publicly
available but can be obtained
from the silicon vendor.

memory and is made
available through newer
versions of the driver if
the flash requires an
upgrade.
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Non Volatile Amount Does this Does this What is the How is data input into this How is this memory write
Memory Type (Size) memory memory purpose of this memory? protected?
store retain data memory?
customer when power
data? is removed?
802.11 WLAN 4kb to 8kb No Yes Stores Programmed at the factory. A utility is required for
EEPROM configuration Tools for writing data to this writing data to this
and calibration  memory are not made public.  memory and is typically
data. not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.
Web Camera 64K bit No Yes Store Web Cam  Using a utility from the device A utility is required for
configuration manufacturer that canberun  writing data to this
and firmware. from Windows. memory and is typically
not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.
Fingerprint Reader 512kByte Yes Yes Stores By enrolling in HP Only a digitally signed
Flash fingerprint ProtectTools Security application can make the
templates. Manager. call to write to the flash.

Questions and answers

1. How can the BIOS settings be restored (returned to factory settings)?
a. Turnon or restart the computer and press F10 when prompted near the bottom of the display.
b. SelectFile, then select Restore defaults.
¢. Follow the on-screen instructions.
d. Select File, save changes and exit, then press Enter.
2. Whatkind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory

module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial number,
data width, speed/timing, voltage and thermal information. This information is written by the module
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is
installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is
not installed in a PC. There are various third party tools available to read SPD memory.

3. Does the “Firmware Hub for System BI0S” contain the BIOS program? Is this chip writable, and if so
how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the
write function.

4. Insome PCsystems, the Firmware Hub for System BIOS is a flash memory chip so that updates can
be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.

5. Whatis meant by “Restore the nonvolatile memory found in Intel-based system boards’?
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This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.
Does resetting the CMOS configuration memory return the PC back to factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not
reset many of the system data and configuration defaults to their factory settings. To return these
system data and configuration defaults to factory settings, refer to question and answer 1 and follow
the instructions for returning the BIOS settings to factory defaults.
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13 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts ac, or from 220 to 240 volts ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or
region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in
the country or region where the power cord set will be used.

e  The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating of 125
or 250V ac, as required by the power system of each country or region.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet
(13 connector for mating with the appliance inlet on the back of the computer.

Requirements for all countries 143



Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Argentina IRAM 1
Australia SAA 1
Austria OVE 1
Belgium CEBEC 1
Brazil ABNT 1
Canada CSA 2
Chile IMQ 1
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
India ISI 1
Israel Sli 1
Italy IMQ 1
Japan JIS 3
The Netherlands KEMA 1
New Zealand SANZ 1
Norway NEMKO 1
The People's Republic of China ccc 4
Saudi Arabia SASO 7
Singapore PSB 1
South Africa SABS 1
South Korea KTL 5
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 6
Thailand TISI 1
The United Kingdom ASTA 1
The United States UL 2

1.  The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm? conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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Country/region Accredited agency Applicable note number

2. Theflexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark. UL file number must be
on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75mm? or 1.25mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4.  The flexible cord must be Type RVV, 3-conductor, 0.75mm? conductor size. Power cord set fittings (appliance coupler and wall
plug) must bear the CCC certification mark.

5.  The flexible cord must be Type HO5VV-F 3X0.75mm? conductor size. KTL logo and individual approval number must be on each
element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3X1.25mm? conductor size. Power cord set fittings (appliance coupler, cable, and wall
plug) must bear the BSMI certification mark.

7. For 127V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL and CSA or C-
UL marks. For 240V ac, the flexible cord must be Type HO5VV-F 3X0.75/1.00mm? conductor size, with plug BS 1363/A with BSI
or ASTA marks.
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14 Recycling

Battery

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/

recycle.

Display

A WARNING! The backlight contains mercury. Caution must be exercised when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

E/%"NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly that
might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see the
Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

g

E%?NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details, such
as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one computer
model to another.
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Perform the following steps:

1.  Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).

4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).
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5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7.  Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use asharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.

10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
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12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel upright.
15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.
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17. Remove the backlight frame from the display panel.

L
-rrr-rrr-rrr-v—r-rr-:_"ll-

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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